Contents

Introduction 1
Research Wizard 4.0 Overview ................................................................. 1
Using Research Wizard ........................................................................... 1

Guided Tour 2
Getting Started in Research Wizard ....................................................... 2
Parts of Research Wizard ......................................................................... 3
Navigating in Research Wizard ................................................................. 3
Report Export Options ........................................................................... 3
Exporting to Excel .................................................................................. 3
Exporting to Text Files ............................................................................ 3
Print Options in Research Wizard ........................................................... 4
Printer Setup .......................................................................................... 4
Printing Reports ..................................................................................... 4
Using Mouse in Research Wizard ............................................................ 4
Screening Quick Start Guide ................................................................. 4
How to Save Tickers After Screening ..................................................... 5
Creating Reports ................................................................................... 5
Running Reports .................................................................................. 6
EZ Screen Quick Start Guide ................................................................. 6
Alerts Quick Start Guide ......................................................................... 6
Snapshot Quick Start Guide ................................................................. 7
Link to Integrated Company Analysis ..................................................... 7

Screening: Basic Steps 8
Overview of Research Wizard Screening Process .................................. 8
Screening Menu .................................................................................... 8
Selecting Databases .............................................................................. 8
Available Zacks Databases .................................................................... 9
Zacks Database Concepts ....................................................................... 10
Understanding Data Time Periods ....................................................... 10
Specifying Data Periods ....................................................................... 12
Item Frequency Codes ........................................................................... 12
Fiscal Periods Abbreviations .................................................................. 13
Viewing Data in Research Wizard ....................................................... 13
Accessing Single Company Data ........................................................ 13
Viewing Single Item Statistics ............................................................. 14
Available Screening Operators .......................................................... 15
How to Screen: Basic Concepts ............................................................. 15
Using Historical Search Option in Screening ....................................... 16
Saving Screens .................................................................................... 16
Running Saved Screens ........................................................................ 16
Combining Screen Definitions ............................................................ 16
Editing Screens Overview ..................................................................... 17
Adding Screening Criteria ..................................................................... 17
Editing Screen Definitions .................................................................... 17
Clearing Screening and Reporting Criteria .......................................... 19
Viewing Active Universe ....................................................................... 20
How to Save Tickers After Screening ................................................... 20

Report Writing: Basic Steps 21
Working with Reports ........................................................................... 21
Creating New Reports ................................................................ .......... 21
Contents

Creating Reports for Existing Portfolio .................................................................21
Editing Report Definitions .....................................................................................22
Adding Items to Report .........................................................................................22
Editing Report Definitions Overview .................................................................22
Clearing Report Definition ...................................................................................27

Sorting and Organizing Reports ...........................................................................27
Organize Report Options .......................................................................................27
Organizing Reports ...............................................................................................28
Sorting Reports .....................................................................................................28
Running Existing Reports ....................................................................................28
Adding/Removing Indices Options in Reports ....................................................29
Adding Titles to Reports .........................................................................................29

Working with Portfolios .........................................................................................30
Ticker List Overview..............................................................................................30
Creating Ticker Lists ..............................................................................................30
Selecting Ticker Lists .............................................................................................31
Editing Ticker List ..................................................................................................31

Working with Calculation Expressions ...............................................................32
Understanding Calculation Expression (User–Defined Calculations) .......................32
Building Calculation Expression Basics ..................................................................32
Calculation Expression Parameters .......................................................................34
Overview ................................................................................................................34
Calculation Expression Operator Categories .......................................................35
Calculation Expression Function Categories .......................................................35
Calculation Expression: Math ................................................................................39
Using Math Functions in Screening Calculation Expression .....................................39
Adding Calculation Expression to Reports: Math ..................................................40
Available Math Functions .......................................................................................40
Calculation Expression: Universe Aggregate ........................................................41
Using Universe Aggregate Functions in Screening Calculation Expression ................41
Adding Calculation Expression to Reports: Universe Aggregate ............................41
Available Universe Aggregate Functions .............................................................42
Using S&P 500 Aggregate Functions in Screening Calculation Expression .................42
Adding Calculation Expression to Reports: S&P 500 Aggregate ............................43
Available S&P 500 Aggregate Functions ...............................................................44
Calculation Expression: X Industry Aggregate .....................................................44
Using X Industry Aggregate Functions in Screening Calculation Expression ............44
Adding Calculation Expression to Reports: X Industry Aggregate .........................45
Available X Industry Aggregate Functions ..........................................................45
Calculation Expression: M Industry Aggregate .....................................................46
Using M Industry Aggregate Functions in Screening Calculation Expression ............46
Adding Calculation Expression to Reports: M Industry Aggregate .........................46
Available M Industry Aggregate Functions ..........................................................47
Calculation Expression: Sector Aggregate ............................................................47
Using Sector Aggregate Functions in Screening Calculation Expression ..................47
Adding Calculation Expression to Reports: Sector Aggregates ................................48
Available Sector Aggregate Functions ....................................................................49
Calculation Expression: Rank ................................................................................49
Overview ................................................................................................................49
Using Rank Functions: Ordinal Ranking in Screening Calculation Expression ..........49
Adding Calculation Expression to Reports: Ordinal Ranking ....................................50
Using Rank Functions: Uniform or Histogram Ranking in Screening Calculation Expression ..................................................................................................................51
Adding Calculation Expression to Reports: Uniform or Histogram Ranking ............52
## Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>EZ Screen</strong></td>
<td>85</td>
</tr>
<tr>
<td>How to Use EZ Screen</td>
<td>85</td>
</tr>
<tr>
<td>EZ Screen Functionality Overview</td>
<td>85</td>
</tr>
<tr>
<td>EZ Screen: 13 Screening Items</td>
<td>86</td>
</tr>
<tr>
<td>EZ Screen: 6 Screening Criteria</td>
<td>86</td>
</tr>
<tr>
<td>Screening Priority</td>
<td>87</td>
</tr>
<tr>
<td>EZ Screen Screening and Reporting</td>
<td>87</td>
</tr>
<tr>
<td>Saving EZ Screen Definitions</td>
<td>87</td>
</tr>
<tr>
<td>Running Saved EZ Screen Definitions</td>
<td>87</td>
</tr>
<tr>
<td><strong>Alerts</strong></td>
<td>88</td>
</tr>
<tr>
<td>Alert Reports Overview</td>
<td>88</td>
</tr>
<tr>
<td>Using Alert Reports</td>
<td>88</td>
</tr>
<tr>
<td>Specifying Alerts Parameters</td>
<td>89</td>
</tr>
<tr>
<td>Additional Alert Parameters</td>
<td>90</td>
</tr>
<tr>
<td>Alert Report Categories</td>
<td>91</td>
</tr>
<tr>
<td>Broker Recommendations Category</td>
<td>91</td>
</tr>
<tr>
<td>Estimate Revisions Category</td>
<td>93</td>
</tr>
<tr>
<td>EPS Surprise Category</td>
<td>94</td>
</tr>
<tr>
<td>Upside Potential Category</td>
<td>95</td>
</tr>
<tr>
<td>Price Action Category</td>
<td>96</td>
</tr>
<tr>
<td><strong>Snapshot Reports</strong></td>
<td>97</td>
</tr>
<tr>
<td>Snapshot Report Options</td>
<td>97</td>
</tr>
<tr>
<td>Working with Zacks Company Snapshot</td>
<td>97</td>
</tr>
<tr>
<td>Accessing Zacks Company Snapshot</td>
<td>97</td>
</tr>
<tr>
<td>Printing Zacks Company Snapshot Reports for Active Tickers</td>
<td>98</td>
</tr>
<tr>
<td>Zacks Company Snapshot Report Overview</td>
<td>98</td>
</tr>
<tr>
<td>Zacks Company Snapshot Report Components</td>
<td>98</td>
</tr>
<tr>
<td>Working with Expanded Company Reports</td>
<td>101</td>
</tr>
<tr>
<td>Accessing Expanded Company Reports</td>
<td>102</td>
</tr>
<tr>
<td>Expanded Company Reports Categories</td>
<td>102</td>
</tr>
<tr>
<td>Fundamental Reports</td>
<td>102</td>
</tr>
<tr>
<td>Return on Equity Reports</td>
<td>103</td>
</tr>
<tr>
<td>Risk Rating/Bankruptcy Reports</td>
<td>103</td>
</tr>
<tr>
<td>Business Description &amp; Management Discussion Reports</td>
<td>103</td>
</tr>
<tr>
<td>Business Descriptions Reports</td>
<td>103</td>
</tr>
<tr>
<td>Management's Discussion and Analysis Reports</td>
<td>103</td>
</tr>
<tr>
<td>Insider Trading Report</td>
<td>104</td>
</tr>
<tr>
<td>Link to Integrated Company Analysis</td>
<td>104</td>
</tr>
<tr>
<td><strong>Appendix</strong></td>
<td>105</td>
</tr>
<tr>
<td>List of Zacks Sector and Industry Designations</td>
<td>105</td>
</tr>
<tr>
<td>Zacks X (Expanded) Sector Groups</td>
<td>105</td>
</tr>
<tr>
<td>Zacks M (Medium) Industry Groups</td>
<td>105</td>
</tr>
<tr>
<td>Zacks X (Expanded) Industry Groups</td>
<td>106</td>
</tr>
<tr>
<td><strong>Glossary of Terms</strong></td>
<td>107</td>
</tr>
</tbody>
</table>
Introduction

Research Wizard 4.0 Overview

The Research Wizard is a powerful equity screening program, ideal for identifying new buying opportunities, monitoring your portfolios and backtesting for performance.

The Research Wizard may be used to:

- Perform interactive screening to explore market distributions and find companies for investment consideration.
- Run pre-defined screens to generate and keep current list of possible new companies of interest.
- Examine the fundamental characteristics of current holdings or search for potential valuable additions to your portfolio.
- Access pre-configured multi-company reports, as well as reports you may create or modify independently.
- Perform user-defined calculations; screen and report on resulting values.
- Access pre-configured reports that alert you to the price-driven events affecting stocks in your portfolio (i.e. changes in brokerage analyst EPS estimates, changes in brokerage firm recommendations, and EPS surprises).
- View your screen’s performance relative to a benchmark over time.

Using Research Wizard

Do you want to identify certain low P/E stocks that reported EPS during the last 15 days, had earnings surprises above their industry median, had upward estimate revisions and no decreases in broker recommendations? Do you want to search for mid-cap stocks in the specific industries that are 30% off their highs? Or perhaps, you only want to view stocks with earnings growth above their industry median and with P/E and P/B below their industry medians. You can have answers to these questions in seconds, and after saving your searching criteria, generate and maintain a Followed List.

Once you have found promising candidates, you can run or modify pre-configured multi-company reports or create your own. These reports will help you monitor individual components affecting stocks in your portfolio. After your report is produced, you can select from a variety of export options to transfer your report’s contents for use with other applications.

Research Wizard is also an automation tool. This automation ability (called scripting) is a time-saver that allows you to combine repetitive tasks into one process, similar to macros in the spreadsheet and word processing programs. Once you have defined your script, with one click, you can then run a series of screens and reports, and then print or export the results.
Guided Tour

Getting Started in Research Wizard

Using Research Wizard is quite easy. The Research Wizard’s main display is the screening interface. To aid in your work with Zacks data, the company’s information is organized into several categories and sub-categories. Each sub-category contains individual items grouped by item category.

Zacks data includes: company description, size and share volume information, price and price changes, analyst recommendations and recommendation changes, annual and quarterly Consensus estimate data, expected report dates, growth rates, actual EPS, valuation data, financial ratios, and Income/Balance Sheet items.

As you select an item from its corresponding category, a brief item’s description will be displayed in the item description box above the Categories and Items section.

The Research Wizard main menu.
Parts of Research Wizard

The following is a description of the Research Wizard display elements and access buttons:

**Title Bar** – the bar at the top of the Research Wizard window.

**Menu Bar** – a list of menu names displayed below the title bar of Research Wizard.

**Menu** – a pull-down list of commands.

**Command** – a function or action chosen from a pull-down menu.

**Toolbar** – a bar containing tools (buttons) that, when chosen with the mouse pointer, produce a function or action.

**Access Buttons** – EZ Screen, Alerts, Snapshot, and Run Query:

- **EZ Screen** – a quick way to select companies using 13-pre-selected screening criteria.
- **Alerts** – pre-formatted reports that highlight several price-driving events, alerting you to possible future price changes.
- **Snapshot** – access to over 15 pre-formatted single company reports.
- **Run Query** – execute your search and report commands.

Navigating in Research Wizard

Use the BACK and FORWARD buttons on the Research Wizard toolbar to switch between the Research Wizard main interface and the report output display.

Report Export Options

Once your reports have been displayed, you can export the data to a variety of the file formats. You can export the report data to Excel or save it in one of the following text file types: text (tab-delimited), formatted text (space-delimited) or CSV (comma-delimited).

**Exporting to Excel**

To export the report data to Excel (after running a report), from the **Data** menu, select the Export to Excel command. The Excel application will automatically start and the report will be displayed in the **Export** worksheet.

The default file name for the exported file is export.csv (in the comma-delimited format). If you want to use the exported file later, remember to save it under the different name before exiting Excel.

**Exporting to Text Files**

To export the report data to the text file after running a report, follow these steps:
1. From the **Data** menu, select the Export to Text command and then select from the following text file options:
   - Select Text option to save the file in the Tab Delimited (that is, separated by tab characters) format.
   - Select Formatted Text option to save file in the Space Delimited (separated by spaces) format.
   - Select CSV option to save file in the Comma Delimited (separated by commas) format.

2. At the **Save** dialog box, type the file name and specify the file location (the default export folder is \zir\output).

3. Click **Save**.

### Print Options in Research Wizard

Print options in Research Wizard include Printer Setup and Print Report.

**Printer Setup**

To select or modify printer options, select the Printer Setup command from the **File** menu.

**Printing Reports**

To enable the Print Report option, you have to run a report first.

To print the report, select the Print Report command from the **File** menu or click the **Print Report** button.

### Using Mouse in Research Wizard

Right-clicking your mouse in specific areas of the interface of Research Wizard, allows you to perform the following functions:

1. To screen by a database item, to add a database item to the report, or view item's summary, right-click your mouse on that item inside the **Items** section at the main menu.

2. To get the Zacks Company Snapshot report or a direct link to the Integrated Company Analysis module for the selected company, right-click your mouse on that company while at the report output display.

3. To get the Edit menu in the **Screening Criteria** or **Report Definition** tables, right-click your mouse while in the corresponding table at the main menu.

### Screening Quick Start Guide

To begin the screening process, follow these steps:

1. From the list of **Categories**, choose a category and then highlight a data item from the list of **Items**.

2. Double-click the selected database item (alternatively, select the Screen by Database Item command from the **Screen** menu) or click the **Screen by Database Item** button. The **Screen By** dialog box will appear.
3. In the Screen By menu, enter the parameters for your screen and click OK. The screening item will appear in the Screening Criteria table (below the Categories and Items section). Each screening item will also be added to the Report Definition table.

4. To run the screen, click the Run Query button.

**Tip**
To add a screening item with the mouse, highlight that item in the Items section and right-click your mouse. Select the Screen by Database Item command from the menu.

**How to Save Tickers After Screening**

After finding the universe that matches your criteria, you can save the list of companies that passed your screen in the Ticker List.

To save companies (after running a screen) as a Ticker List, follow these steps:

1. From the Portfolio menu, select the Save Tickers as List command or click the Save Ticker List button.

2. The Save Ticker List dialog box will appear and the default folder for the Ticker List files will be shown (\zir\ports). To save the file in a different folder, click a different drive in the Save in box, or double-click a different folder in the folder list.

3. In the File name box, type a name for the Ticker List.

4. Click Save.

**Tip**
To save companies as a portfolio at the report output menu, from the Data menu, click Save Tickers As List. At the Ticker List dialog box, specify the name and location of the portfolio. Click Save.

**Creating Reports**

There are two ways to create a report in the Research Wizard. You can display items used in your screening definition, or you can select items for your portfolio (Ticker List).

**Creating Reports for Existing Portfolio**

To create a report for the existing Ticker List, follow these steps:

1. From the Portfolio menu, select the Open Ticker List command or click the Open Ticker List button and choose the Ticker List. The Screening Criteria table will show the Ticker List name and the number of companies in it.

2. To add a database item to your report, select that item from the Items section and click the Add Item to Report button (alternatively, from the Report menu, choose the Add Database Item command). The added item will appear in the Report Definition table.

3. To save the report for future uses, select the Save Report Definition command from the Report menu.

4. The Report Definition dialog box will appear and the default folder for the report files will be shown (usually:\zir\inputs). To save the file in a different folder, click a different drive in the Save in box, or double-click a different folder in the folder list.
5. In the File name box, type a name for the report (all reports have extension *.rpd) and click Save.

**Tip**
To add an item to your report with the mouse, highlight that item in the Items section and right-click your mouse. Select the Add Database Item to Report command from the menu.

**Running Reports**
To run an existing report, follow these steps:

1. From the Report menu, select the Open Report Definition command. The Report Definition dialog box will appear. Saved reports usually appear in the :\zir\inputs folder and have extension *.rpd.
2. Select a report and click Open. The Report Definition table will fill up.
3. Click Run Query to display the report.

The Research Wizard includes several pre-formatted sample reports.

**EZ Screen Quick Start Guide**
Click the EZ Screen button from the Research Wizard display to access the EZ Screen menu.

The EZ Screen has thirteen pre-selected items and six pre-defined criteria. You assign the Priority rank. A Priority rank (1-13) determines the order in which the software will run the screen. The default priority is from top-to-bottom.

You may want to include only few items for your screening by selecting values from the six criteria options. If you want to include an item in your screen, select a criterion and its value from the Criteria pull-down menu. If you do not want an item to be in your screen, leave its Criteria option box as Not Applicable.

After making your selections, click the Run button to perform the screen and generate a report. The EZ Screen reports will include all thirteen items shown in the menu.

**Alerts Quick Start Guide**
Select the Alerts button from the Research Wizard display to access the Alert Reports menu.

To run an Alert report, follow these steps:

1. Select a report from the report categories.
2. Specify if you want this report for a portfolio or a full universe (all available companies in Zacks database).
3. Select any additional parameters, when applicable.
4. Click the Run Report button to display the report.
Snapshot Quick Start Guide

Click the Snapshot button from the Research Wizard display to access the Company Reports menu.

To run a company report, follow these steps:

1. At the Company Reports menu, type a ticker symbol into the Enter Ticker box.
2. Specify the report type (Zacks Company Snapshot or Expanded Company Reports) by selecting the corresponding radio button.
3. If you specified the Zacks Company Snapshot option, just click OK to display the report.
4. If you specified the Expanded Company Reports option, select a report from the reports pull-down menu, and then click OK. The report will be displayed in your browser window. (To switch back to the Research Wizard, click the Research Wizard button on your Windows taskbar).

Link to Integrated Company Analysis

If you have the Zacks product, Integrated Company Analysis (ICA), you can have an instantaneous link to that module.

To access ICA from the Research Wizard, follow these steps:

1. Click the Snapshot button from the Research Wizard display to access the Company Reports menu.
2. At the Company Reports menu, type a ticker symbol into the Enter Ticker box.
3. Select the Integrated Company Analysis radio button and click OK.
4. ICA will open in a separate window. To switch back to the Research Wizard, click the Research Wizard button on your Windows taskbar.
Screening: Basic Steps

Overview of Research Wizard Screening Process

The Research Wizard screening capabilities provide a powerful tool for examining the fundamental characteristics of your current holdings or searching for potential valuable additions to your portfolio. With the Research Wizard you can perform interactive screening to analyze market distribution and find companies that can serve as potential candidates for investments.

The Research Wizard also allows you to explore the Zacks databases of over 6,500 stocks, using over 600 pre-defined items or an unlimited number of your own custom calculations.

Once your criteria have been specified, you can save them for the future use with the updated data, or run a series of backtest to see how these strategies have performed in the past.

Screening Menu

The Research Wizard layout is organized to provide you with the most convenient way to analyze Zacks data. The data is organized into several categories. Each category contains individual items available for screening and reporting.

As you select an item from its corresponding category, a brief item’s description will be displayed in the item description box above the items and categories.

In addition, the item’s frequency (quarterly, weekly, etc.) and number of periods (3, 6, 9, etc.) available will be shown.

Selecting Databases

The Current Market database (DBCM.DBS) is Research Wizard’s default database. To select another database, follow these steps:

1. From the File menu, select Open Database.
2. At the Zacks Databases menu, choose a database by highlighting its name.
3. Click OK.
Available Zacks Databases

The following is a list of available Zacks databases.

**DBCM**: Current Market database containing quarterly and annual consensus EPS estimates, market data, fundamental data, growth rates, valuation ratios and supplementary information.

**AGGIND**: Aggregate Industry database containing current fundamental data aggregated by Zacks Expanded Industry Groups.

**AGGSEC**: Aggregate Sector database containing current fundamental data aggregated by Zacks Expanded Sector Groups.

**DBZHE**: Monthly Historical database containing data for fundamental estimate and ratio items for entire current universe.

**DBDA**: Fundamental Historical Annual Data database containing annual income statements, balance sheet and cash flow items; 10K data.

**DBDQ**: Fundamental Historical Quarterly Data database containing quarterly income statement and balance sheet items; 10Q data.

**ZBT_PRI**: Zacks Primary backtesting database containing 15 years of quarterly EPS data and monthly price, return and estimate data.

**ZBT_SEC**: Zacks Secondary backtesting database containing 15 years of quarterly EPS data and monthly price, return and estimate data.

**DBDP**: Daily Historical Prices database containing 560 days of daily price information.

**DBWP**: Weekly Historical Prices database containing 270 weeks of weekly price data.

**DBQUOTE**: Intraday (15-20 minutes delayed) prices database.

Research Wizard works with DBCM ticker set.

Setting Default Database

You can specify what database will be loaded the moment you start Research Wizard.

To set a default database, follow these steps:

1. From the **Tools** menu, select **Options**.
2. At the **Options** dialog box, click the **Browse** button.
3. At the Zacks Databases menu, select a database from the list and click OK.

4. At the Options menu, click OK again.

**Resetting Default Database**

When in the process of working with several databases you can quickly switch to the default database by selecting the Reset Database command from the File menu.

**Zacks Database Concepts**

The Research Wizard operates on a proprietary Zacks database structure. Conceptually, Zacks database consists of a set of time-series items for a set of companies. Each time series has a calendar (daily, weekly, monthly, quarterly, or annual) or fiscal (fiscal quarterly or fiscal annual) frequency, and is maintained for a fixed number of periods of that frequency. As an example, month-end closing prices (Item 6 in the Zacks Current Market databases, DBCM) have a calendar-monthly frequency and are maintained for 13 periods (13 months).

In addition to the dated frequencies, two non-periodic frequencies may be included in a database. An item may have an X frequency, whereby no date is associated with the data, or an E frequency where each data item has a specific non-periodic date associated with it.

One vitally important characteristic of a Zacks database is the END DATE. This date indicates a database update date. The dates associated with every element in an item’s time series are determined by the database end Date and the item’s frequency. For example, a fiscal quarterly EPS series will start with the last completed fiscal quarter before the End Date. Fiscal annual EPS data will start with the most recently completed company fiscal years as of the End Date.

**Understanding Data Time Periods**

The data items in the Zacks databases can be time-series items (have multiple periods). Period 1 in the Zacks databases is created as soon as the accounting period that it describes is complete. For example, on January 2, a firm with a December 31 fiscal year end will have period 1 earnings with a date of 12/31. In this case, Period 1 for this item will be N/A until the company releases its earnings several weeks later.

By default, when you specify an item for the screen or a report, the Research Wizard will select the first non-N/A value (called period Recent). This could be data from the previous accounting period (in addition, the time period in the screening and reporting menu is presented on calendarized basis).

To align all items by the same period, you may want to use the specific period designations for your screens and reports such as: #1, #2, #3, etc. To add multiple periods, you can also use choices Today (meaning period #1), and Today-N Periods (select number of periods to go back).

**Example using Quarterly Items:** On September 29, 2000, DBCM i28 (Actual EPS Q before NRI) will have the calendarized completed quarterly periods specified as 06/2000, 03/2000; 12/1999, etc. Selecting the first calendarized period (06/2000) will pull companies with fiscal quarters ending
on or before June (however, this data will not necessarily be from period #1, as explained next).

If companies have fiscal quarters that ended in July and August, that would be the period #1; however, selecting period 6/2000 will show April Quarter end data (or period #2), for April, July, and October FYE companies and will show May Quarter end data (or period #2), for companies with May, August, and November FY end months.

You can specify your screen or report choice as #1, #2, #3, etc., to align data by the same period. To add multiple periods, you can also use option Today (meaning period #1), and Today-nQ Periods (specify number of quarterly periods to go back).

**Example using Annual Items:** On October 4, 2000, DBCM item 80, Annual Sales, will have the first calendarized choice as 1999. Selecting the first calendarized option 1999 will select period #2 data for companies with the FY ending between January 2000 – September 2000. To view the period #1 for those companies, use option Today. For companies with FY ending in October-December, the calendarized option 1999 will select period #1 data, since their FY have not ended as of the beginning of October.

You can specify your screen or report choice as #1, #2, #3, etc. to align data by the same period. To add multiple periods, you can also use choices Today, and Today-nY Periods (specify number of annual periods to go back).

In addition, companies that have their FY ended by October 2000, but have not reported their data yet, will have #1 as N/A.

The time period specifications are summarized in this table:

<table>
<thead>
<tr>
<th>Period</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Recent</strong></td>
<td>Specifies the period with the first non-N/A value of the item.</td>
</tr>
<tr>
<td><strong>Today</strong></td>
<td>The first available data period (can also be specified as #1). Note that the data in this period may be N/A.</td>
</tr>
<tr>
<td><strong>#1</strong> (select period number)</td>
<td>Use the number &quot;#&quot; sign and a period number to select a specific period of data. Data periods are labeled from most recent to least recent, so Period 1 is the most recent date.</td>
</tr>
</tbody>
</table>
Specifying Data Periods

The following table shows how you can select a specific time period for the screen or report items.

<table>
<thead>
<tr>
<th>Data Elements</th>
<th>Usage</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>ix[Recent]</td>
<td>i93[Recent]</td>
<td>Specifies the period with the first non-N/A value of the item.</td>
</tr>
<tr>
<td>ix[# period]</td>
<td>i108[#4]</td>
<td>Specifies the fourth period of the item.</td>
</tr>
<tr>
<td>ix[Today]</td>
<td>i7[Today]</td>
<td>Refers to the first period. Note that the data in this period may be N/A.</td>
</tr>
<tr>
<td>ix[-4]</td>
<td>i7[-4]</td>
<td>Lag item 7 by four periods for each data point.</td>
</tr>
<tr>
<td>ix[R-2Q]</td>
<td>i27[R-2Q]</td>
<td>Specified the two quarterly periods before the most recent period with non-N/A value of item.</td>
</tr>
<tr>
<td>ix[Recent – 3W]</td>
<td>i7[Recent – 3W]</td>
<td>Specifies a period that is 3 weeks before the most recent period with non-N/A value of the item.</td>
</tr>
<tr>
<td>ix[Today – 15D]</td>
<td>i7[Today – 15D]</td>
<td>Refers to a period that is 15 days before the first period.</td>
</tr>
<tr>
<td>ix[Today – 5M]</td>
<td>i7[Today – 5M]</td>
<td>Refers to a period that is 5 months before the first period.</td>
</tr>
<tr>
<td>ix[Date, Ticker]</td>
<td>i7[12/1998, SPAL]</td>
<td>Refers to the data for SPAL for the 12/1998 period. Useful in relative calculation using SPAL or an Index ticker</td>
</tr>
<tr>
<td>ix[Today- 2Y]</td>
<td>Sales[i80[Today – 2Y]]</td>
<td>Specifies a period that is 2 years before the first period.</td>
</tr>
</tbody>
</table>

Item Frequency Codes

The items in Zacks databases can have the following frequency codes:

<table>
<thead>
<tr>
<th>Calendar Frequencies</th>
<th>Fiscal Frequencies</th>
</tr>
</thead>
<tbody>
<tr>
<td>D - Daily (business days only)</td>
<td>F - Fiscal Quarterly</td>
</tr>
<tr>
<td>W - Weekly (Friday end)</td>
<td>Y - Fiscal Annual</td>
</tr>
<tr>
<td>M - Monthly</td>
<td></td>
</tr>
<tr>
<td>Q - Calendar Quarterly</td>
<td></td>
</tr>
<tr>
<td>A - Calendar Annual</td>
<td></td>
</tr>
</tbody>
</table>

Other Frequencies

E - Event frequency (A special frequency, in which a non-periodic date is assigned to the item. Split adjustment factor for stock splits and dividends, which occur on specific and non-periodic dates, is an example of E-frequency item).

X - No Frequency (No date is assigned to the item, for example: Ticker or Company Name).
Fiscal Periods Abbreviations

The following table explains Fiscal and Quarterly abbreviations used in Research Wizard:

<table>
<thead>
<tr>
<th>Fiscal Abbreviations</th>
<th>Quarterly Abbreviations</th>
</tr>
</thead>
<tbody>
<tr>
<td>F(0) – Completed fiscal year</td>
<td>Q(0) – Completed fiscal quarter</td>
</tr>
<tr>
<td>F(1) – Current fiscal year</td>
<td>Q(1) – Current fiscal quarter</td>
</tr>
<tr>
<td>F(2) – Next fiscal year</td>
<td>Q(2) – Next fiscal quarter</td>
</tr>
<tr>
<td>F(3) – Two years from the current fiscal year</td>
<td>Q(3) – Two quarters from the current fiscal quarter</td>
</tr>
<tr>
<td></td>
<td>Q(4) – Three quarters from the current fiscal quarter</td>
</tr>
</tbody>
</table>

Viewing Data in Research Wizard

The Research Wizard provides you with the ability to view the data for a single company or a single item.

Accessing Single Company Data

You can quickly view the active database data for a particular company by following these steps:

1. From the Report menu, click Company Data. The Company Data window appears. This window displays data Categories and Items using the same layout as the main screening menu.
2. Type the company's ticker symbol in the Ticker box and click Go. The data for all items in each category will be displayed. As you browse each category, the item information for the company will be changing accordingly. The Company Data will show item's Recent period (the first period that is not N/A).
3. To exit the Company Data window, click Close.

Company Data display.
Viewing Single Item Statistics

Sometimes before defining your screening criteria, you want to have a visual impression of how the companies in the full universe are distributed, making it easier to determine appropriate operators and values for screening.

To view single item statistics, follow these steps:

1. From the **Screen** menu, select Item Summary. The **Item Summary** window appears. This window contains the following item statistics for the full universe:
   - High – the highest value for the item in the universe
   - Low – the lowest value for the item in the universe
   - Mean – the average value for the item in the universe
   - Median – the median value for the item in the universe
   - Standard Deviation – the standard deviation for the item in the universe

   In addition, the total number of companies in the database and the number of N/A values for the item are noted.

**Item Summary Histogram Table**

Below the item's statistics, the item's histogram table is shown. This display groups the values into equal ranges around the item's mean value. The range is calculated as the fraction of the Standard Deviation for the selected item. The fraction of the Standard Deviation used will depend on the Standard Deviation value: the bigger the value, the bigger the fraction that is used. In addition, each bar represents the number of companies within a certain range of values of the specified item, allowing a quick graphical look at how the companies in the universe are distributed.

The Item Summary histogram table has 3 rows. The first row contains ranges of Standard Deviation Segments fractions on the left and on the right side of the mean. The second row contains the number of companies falling within the particular range. The third row shows the percentage of companies within the particular range.
Tip
Another way to access the Item Summary option is to follow these steps:
1. Right-click your mouse on the selected item inside the Items section on the Research Wizard main menu.
2. Select the Item Summary option from the drop-down menu.

Available Screening Operators

<table>
<thead>
<tr>
<th>Operator</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>&gt;</td>
<td>Greater than X</td>
</tr>
<tr>
<td>&lt;</td>
<td>Less than X</td>
</tr>
<tr>
<td>=</td>
<td>Equal to X</td>
</tr>
<tr>
<td>&lt;&gt;</td>
<td>Not equal to X</td>
</tr>
<tr>
<td>&gt;=</td>
<td>Greater than or equal to X</td>
</tr>
<tr>
<td>&lt;=</td>
<td>Less than or equal to X</td>
</tr>
<tr>
<td>In</td>
<td>Specifies a range to include in the criteria</td>
</tr>
<tr>
<td>Out</td>
<td>Specifies a range to be excluded from the criteria</td>
</tr>
<tr>
<td>Top #</td>
<td>Top number of companies</td>
</tr>
<tr>
<td>Top %</td>
<td>Top percentage of companies</td>
</tr>
<tr>
<td>Bot #</td>
<td>Bottom number of companies</td>
</tr>
<tr>
<td>Bot %</td>
<td>Bottom percentage of companies</td>
</tr>
</tbody>
</table>

"Top" and "Bottom" operators refer to the value of a data item and do not imply qualitative characteristics of an item, they just select the largest or the smallest value.

How to Screen: Basic Concepts

To begin the screening process, follow these steps:
1. From the list of Categories, choose a category, subcategory and then highlight a data item from the Items section.
2. Double-click the selected database item or click the Screen by Database item button. The Screen By dialog box will appear.

![Screen by 20% Price Change in the last 4 weeks.](image)

3. At the Screen By dialog box, enter the parameters for your screen. You can compare the selected item to a Value (any number) or a Group. If you are comparing to a specific Value, enter that number into the value data entry box. When you are comparing to a Group (Industry, Sector or...
S&P 500), select it from the pull-down menu and then specify the method of aggregation (mean, median).

4. Next, choose an operator from the operators pull-down menu and click OK.

5. The screening item will appear in the Screening Criteria table (below the Categories and Items section). Each screening item will also be added to the Report Definition table.

6. To run the screen, click the Run Query button.

**Tip** To add a screening item with the mouse, highlight that item in the Items section and right-click your mouse Select the Screen by Database Item command from the menu.

### Using Historical Search Option in Screening

When an item in a database has more then one period associated with it, the Screen By dialog box has a special check box: Historical Search. The Historical Search option allows you to screen on several data periods. In addition, you can specify whether you want the specific conditions to be met in Every or Any time period.

### Saving Screens

You can save your screen definition for the later use. To save a screen definition after executing a series of screens, follow these steps:

1. From the Screen menu, select the Save Screen Definition command.
2. The Screen Definition dialog box will appear. In the File Name box, type a name for the saved screen and then click Save. The screen definition will be saved in a file with the extension *.und.

### Running Saved Screens

To run a saved screen, follow these steps:

1. From the Screen menu, select the Open Screen Definition command.
2. At the Screen Definition menu, select the previously saved screen (files with the extension *.und) and click Open. The Screening Criteria and Report Definition tables will fill up with data.
3. If you want to run both the screen and the report, just click the Run Query button.
4. If you want to run the screen only, select the Clear Report Definition command from the Report menu and then click the Run Query button.

### Combining Screen Definitions

You can combine several screen definitions by following these steps:

1. From the Screen menu, select the Open Screen Definition command and select a screen definition file.
2. At the Screen Definition menu, select the previously saved screen (files with the extension *.und) and click Open. The Screening Criteria and Report Definition tables will fill up with data.
3. From the Screen menu, select the Open Screen Definition command and select second screen definition file. The message “Would you like to CLEAR the Screen Definition?” will appear.

4. Click No. The message “Would you like to CLEAR the Report Definition?” will appear. Select either Yes or No. (Selecting No will leave items used in the first screen definition in the report, selecting Yes will remove items used in the first screen definition from the report and will replace them with the items used in the second screen definition). The screen definitions will be combined.

**Editing Screens Overview**

One way to modify a screen, is to add a new criterion to the screen definition. The other option is to manipulate the existing criterion.

**Adding Screening Criteria**

To add a screening criterion to the existing screen definition, follow these steps:

1. Open the screen definition you want to edit. The Screening Criteria table will fill up.

2. Select a new screening item and then double-click the item’s name in the Items section or click the Screen by Database Item button.

3. At the Screen By menu, enter the data into the Value box. The new item will be added to the Screening Criteria table.

**Tip** To add a screening item with the mouse, highlight that item in the Items section and right-click your mouse. Select the Screen by Database Item command from the menu.

**Editing Screen Definitions**

To edit a criterion in the screen definition, from the Screen menu, select the Edit Screen Definition command to display the following screen editing options:

- **Modify** – changes screening parameters, criterion’s value, time period or name and calculation for the calculated screening item.
- **Cut** – removes the selected criterion from the Screen Definition and places it on the Clipboard.
- **Copy** – copies the selected criterion to the Clipboard.
- **Paste** – inserts the criterion currently placed on the Clipboard at the insertion point in the Screening Criteria table, and replaces any selection. This command is available only if you have cut or copied a criterion.
- **Delete** – permanently removes the criterion from the Screen Definition.
- **Insert** – puts in the criterion currently placed on the Clipboard between the criteria at the insertion point in the Screening Criteria table. This command is available only if you have cut or copied a criterion item.
**Tip**

To get the edit menu in the Screening Criteria table, right-click your mouse inside the Screening Criteria table.

**Modify (Edit Screen Menu)**

The screening criterion can be a database item or a calculated item. This will determine the additional edit options.

**Modifying Database Item**

1. Open the screen definition you want to edit. The Screening Criteria table will fill up.
2. From the Screening Criteria table, highlight the item you want to modify and double-click it (or right-click your mouse on that item to bring up the Edit menu and select the Modify option). The Screen By dialog box will appear.
3. In the Screen By menu, modify the parameters for your screen and click OK.

**Modifying Calculated Item**

1. Open the screen definition you want to edit (if the calculation expression was build using database that is not currently active, you will be prompted to switch to that database). The Screening Criteria table will fill up.
2. From the Screening Criteria table, highlight the calculated item you want to modify and double-click it (or right-click your mouse on that item to bring up the Edit menu and select the Modify option).
3. The Calculation Expression dialog box will appear. Make the necessary changes there and click OK. The Screen By dialog box will appear.
4. In the Screen By menu, modify the parameters for your screen and click OK.

**Cut (Edit Screen Menu)**

To use this option, follow these steps:

1. Open the screen definition you want to edit. The Screening Criteria table will fill up.
2. From the Screening Criteria table, highlight the criterion you want to cut and right-click the mouse on that criterion to bring up the Edit menu and select Cut.

**Copy (Edit Screen Menu)**

To copy screening criteria, follow these steps:

1. Open the screen definition you want to edit. The Screening Criteria table will fill up.
2. In the Screening Criteria table, highlight the criteria you want to copy and right-click the mouse on that criterion to bring up the Edit menu and select the Copy option. (If you want to copy these criteria to another screen definition, switch to that screen definition).
3. In the Screening Criteria table, click where you want the criteria to appear.
4. To replace the criteria, highlight a criterion you want to replace and right-click the mouse to bring up the Edit menu. Select the Paste option.

5. To place the criterion before another one, highlight that criterion and right-click the mouse to bring up the Edit menu. Select the Insert option.

**Paste (Edit Screen Menu)**

This command is available only if you have cut or copied a screening criterion. To replace an existing criterion, in the Screening Criteria table, highlight a criterion you want to replace and right-click the mouse to bring up the Edit menu. Select the Paste option.

**Delete (Edit Screen Menu)**

To delete a criterion, follow these steps:

1. Open the screen definition you want to edit. The Screening Criteria table will fill up.

2. In the Screening Criteria table, highlight the criterion you want to delete.

3. From the Screen menu, select the Modify Screen Definition command and select the Delete option or click the Delete Criterion button.

**Tip**

To delete a criterion from the Screening Criteria table, highlight that item in the Screening Criteria table and right-click your mouse. Select the Delete command from the menu.

**Insert (Edit Screen Menu)**

This command is available only if you have cut or copied a screening criterion. To place the criterion before another one, in the Screening Criteria table, highlight that criterion and right-click the mouse to bring up the Edit menu. Select the Insert option.

**Clearing Screening and Reporting Criteria**

There are three ways to clear the Screening Criteria and Report Definition tables. You can:

a. Clear the Screening Criteria only.

b. Clear both the Screening Criteria and the Report Definition tables.

c. Clear the Report Definition table only.

**To Clear Screening Criteria Only**

1. From the Screen menu, select the Clear Criteria command, or click the Clear Criteria button.

2. The message “Would you like to clear the Report Definition?” will appear. Click No.

3. Only the screening criteria will be removed.

**To Clear both Screening Criteria and Report Definition Tables**

1. From the Screen menu, select the Clear Criteria command, or click the Clear Criteria button.

2. The message “Would you like to clear the Report Definition?” will appear. Click Yes.
3. The **Screening Criteria** and the **Report Definition** tables will be emptied.

**To Clear Report Definition Table Only**

1. From the **Report** menu, select the Clear Report Definition command.
2. The **Report Definition** table will be emptied.

**Viewing Active Universe**

After running a screen, you can view the list of companies that passed your criteria. To view the active tickers, follow these steps:

1. From the **Portfolio** menu, select the View/Edit Active Tickers command, or click the **View/Edit Ticker List** button.
2. The **Ticker List** dialog box will appear containing the companies that passed your screening criteria.
3. You can save the companies that passed your screening criteria in the Ticker List by clicking the **Save** button.

**How to Save Tickers After Screening**

After finding the universe that matches your criteria, you can save the list of companies that passed your screen in a Ticker List.

To save companies (after running a screen) as a Ticker List, follow these steps:

1. From the **Portfolio** menu, select the Save Tickers as List command or click the **Save Ticker List** button.
2. The **Save Ticker List** dialog box will appear and the default folder for the Ticker List files will be shown (:\zir\ports). To save the file in a different folder, specify that drive in the **Save in** box, or double-click a different folder in the folder list.
3. In the **File name** box, type a name for the Ticker List.
4. Click **Save**.

**Tip**

To save tickers as portfolio while a the report output menu, select **Save Tickers as List** command from the **Data** menu.
Report Writing: Basic Steps

Working with Reports

The Research Wizard allows you to create multi-company reports that combine Zacks database items and your own calculated items. The Research Wizard also includes several sample reports. The reports have extension *.rpd and are located in the :\zir\inputs folder.

Creating New Reports

There are two ways to create a report in the Research Wizard. You can display items used in your screening definition, or you can select items for your portfolio (Ticker List). When you build the screen definitions in the Research Wizard, the screening criteria items are automatically added to the Report Definition table. By default, the report will always include the Company Name and the Ticker items.

In order to run a report, you must have the Screening Criteria defined first. The Screening Criteria could be a screen definition or a portfolio.

Creating Reports for Existing Portfolio

To create a report for the existing Ticker List, follow these steps:

1. From the Portfolio menu, select the Open Ticker List command or click the Open Ticker List button and choose your Ticker List.

2. The Screening Criteria table will show the Ticker List name and the number of companies in it.

3. To add a database item to your report, select that item from the Items section and click the Add Item to Report button (or from the Report menu choose the Add Database Item command).

4. The added item will appear in the Report Definition table.

5. To save the report for future uses, select the Save Report Definition command from the Report menu.

6. The Report Definition dialog box will appear and the default folder for the report files will be shown (usually :\zir\inputs). To save the file in a different folder, click a different drive in the Save in box, or double-click a different folder in the folder list.

7. In the File name box, type a name for the report (all reports have extension *.rpd).

8. Click Save.

Tip

To add an item to your report with the mouse, highlight that item in the Items section and right-click your mouse. Select the Add Database Item to Report command from the menu.

Adding Multi-Period Data Items

When adding items that have more than one period associated with them, the Report Column dialog box has a special check box: History. This option
allows you to add multiple data periods at once. After marking the History check box, simply select the desired time periods and click OK.

To align data by the same period, you can specify your selection as period #1, #2, etc.

**Editing Report Definitions**

One way to modify a report is to add a new item to the report definition. The other option is to manipulate the existing items.

**Adding Items to Report**

To add an item to the report, follow these steps:

1. Open the report definition you want to edit. The Report Definition table will fill up.
2. Highlight a new item from the Items section.
3. From the Report menu, select the Add Database Item command or click the Add Database Item button.
4. The item will be added to the Report Definition table.
5. Save your report definition.

**Tip**  
To add an item with the mouse, highlight that item in the Items section and right-click your mouse. Select the Add Database Item to Report command from the menu.

**Editing Report Definitions Overview**

To edit the report, from the Report menu, select the Edit Report Definition command to display the following report editing options:
• **Modify** – changes report column’s name, alignment, format, time period and calculation.

• **Cut** – removes the selected item from the Report Definition table and places it on the Clipboard.

• **Copy** – copies the selected report item to the Clipboard.

• **Paste** – inserts the item currently placed on the Clipboard at the insertion point in the Report Definition table, and replaces any selection. This command is available only if you have cut or copied a report item.

• **Delete** – permanently removes the item from the Report Definition table.

• **Insert** – puts in the item currently placed on the Clipboard between the items at the insertion point in the Report Definition table. This command is available only if you have cut or copied a report item.

**Tip**  
To get the edit menu in the Report Definition table, right-click your mouse inside the Report Definition table.

By default, you report definition will always have Ticker and Company items. These items cannot be deleted.

**Modify Report Overview**

Some options on the Modify menu are available for all types of items. These options include Column Name, Alignment, and Column Format.

Other options become enabled when the item used in a report has more than one data period or is a calculated item. These options are Time Period and Calculation.

To aid in your work, the database name and the item’s number (or a calculation expression) are also noted at the Modify Column dialog box.

**Modify Column options will depend on the item.**

**Column Name** – used to change the item’s name. If the item’s name is long, you can use two lines for the name.

**Alignment** – used to change the item’s position within the column. By default, all items are Right Justified.

**Column Format** – used to change the way numbers are displayed (the first format shown on the list is the default format).
- **Numbers Format**: columns can be formatted to display numbers with zero, one, or more decimal places and use the 1000 separator (,). You can also apply currency, percent, and comma styles to the numbers. The following table explains the column formats:

<table>
<thead>
<tr>
<th>Input</th>
<th>Format</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>21366.8457</td>
<td>#0</td>
<td>21367</td>
</tr>
<tr>
<td>21366.8457</td>
<td>#0.0</td>
<td>21366.8</td>
</tr>
<tr>
<td>21366.8457</td>
<td>#0.00</td>
<td>21366.85</td>
</tr>
<tr>
<td>21366.8457</td>
<td>#0.000</td>
<td>21366.846</td>
</tr>
<tr>
<td>21366.8457</td>
<td>#0.0000</td>
<td>21366.8457</td>
</tr>
<tr>
<td>21366.8457</td>
<td>#,,0</td>
<td>21,367</td>
</tr>
<tr>
<td>21366.8457</td>
<td>#,,0.0</td>
<td>21,366.8</td>
</tr>
<tr>
<td>21366.8457</td>
<td>#,,0.00</td>
<td>21,366.85</td>
</tr>
<tr>
<td>21366.8457</td>
<td>#,,0.000</td>
<td>21,366.846</td>
</tr>
<tr>
<td>21366.8457</td>
<td>#,,0.0000</td>
<td>21,366.8457</td>
</tr>
<tr>
<td>21366.8457</td>
<td>$#,0</td>
<td>$21,367</td>
</tr>
<tr>
<td>21366.8457</td>
<td>$#,0.0</td>
<td>$21,366.8</td>
</tr>
<tr>
<td>21366.8457</td>
<td>$#,0.00</td>
<td>$21,366.85</td>
</tr>
<tr>
<td>1.839</td>
<td>#0%</td>
<td>2%</td>
</tr>
<tr>
<td>1.839</td>
<td>#0.0%</td>
<td>1.8%</td>
</tr>
<tr>
<td>1.839</td>
<td>#0.00%</td>
<td>1.84%</td>
</tr>
</tbody>
</table>

- **Text Capitalization Format**: there are three additional column format options, available for the text items:

<table>
<thead>
<tr>
<th>Format</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text(Upper)</td>
<td>UPPERCASE</td>
</tr>
<tr>
<td>Text(Lower)</td>
<td>lowercase</td>
</tr>
<tr>
<td>Text(Default)</td>
<td>Title Case</td>
</tr>
</tbody>
</table>

**Time Period** – used to change item’s period (available for time-series items only).

**Calculation** – used to change the calculation for the custom item (Calculation Expression).

**Modify (Edit Report Menu)**

The report item can be a database item or a calculated item. This will determine the additional edit options.

**Modifying Database Item**

1. Open the report definition you want to edit. The **Report Definition** table will fill up.

2. From the **Report Definition** table, highlight the item you want to modify and double-click it (or right-click your mouse on that item to bring up the Edit menu and select the Modify option). The **Modify Column** dialog box will appear, where item number and database association are noted.
3. Modify the parameters for your report and click OK.

**Modifying Calculated Item**

1. Open the report definition you want to edit. The *Report Definition* table will fill up.

2. From the *Report Definition* table, highlight the calculated item you want to modify and double-click it (or right-click your mouse on that item to bring up the Edit menu and select the Modify option). The *Modify Column* dialog box will appear, where item formula will be noted.

3. Click the **Calculation** button (if the calculation expression was build using database that is not currently active, you will be prompted to switch to that database). The Calculation Expression dialog box will appear. Make the necessary changes there and click **OK**.

**Cut (Edit Report Menu)**

To cut a report item, follow these steps:

1. Open the report definition you want to edit. The *Report Definition* table will fill up.

2. Highlight the data item you want to cut.
3. From the Report menu, select the Edit Report Definition command and select the Cut option. You can then paste or insert the item anywhere in the report definition (except for two default items: Ticker and Company).

**Tip** To get the Edit menu in the Report Definition table, right-click your mouse inside the Report Definition table.

**Copy (Edit Report Menu)**

To copy a report item, follow these steps:

1. Open the report definition you want to edit. The Report Definition table will fill up.
2. Highlight the data item you want to copy.
3. From the Report menu, select the Edit Report Definition command and select the Copy option. (If you want to copy these items to another report definition, switch to that report).
4. In the Report Definition table, click where you want the item to appear.
5. To replace the item, from the Report menu, select the Edit Report Definition command and select the Paste option.
6. To add the item, from the Report menu, select the Edit Report Definition command and select the Insert option.

**Tip** To get the Edit menu in the Report Definition table, right-click your mouse inside the Report Definition table.

**Paste (Edit Report Menu)**

This command is available only if you have cut or copied a report item. In the Report Definition table, highlight the item you want to replace. From the Report menu, click Edit Report Definition command and select the Paste option.

**Tip** To get the Edit menu in the Report Definition table, right-click your mouse inside the Report Definition table.

**Delete (Edit Report Menu)**

To delete a report item, follow these steps:

1. Open the report definition you want to edit. The Report Definition table will fill up.
2. Highlight the item you want to delete.
3. From the Report menu, select the Edit Report Definition command and select the Delete option.

**Tip** To get the Edit menu in the Report Definition table, right-click your mouse inside the Report Definition table.

**Insert (Edit Report Menu)**

This command is available only if you have cut or copied a report item. In the Report Definition table, click where you want the item to appear. To add the item to the report, from the Report menu, click Edit Report Definition command and select the Insert option.

**Tip** To get the Edit menu in the Report Definition table, right-click your mouse inside the Report Definition table.
Clearing Report Definition

To Clear both Screening Criteria and Report Definition Tables

1. From the Screen menu, select the Clear Criteria command or click the Clear Criteria button.
2. The message “Would you like to clear the Report Definition?” will appear. Click Yes.
3. Both the Screening Criteria and the Report Definition tables will be emptied.

To Clear the Report Definition Table Only

1. From the Report menu, select the Clear Report Definition command.
2. The Report Definition table will be emptied.

Sorting and Organizing Reports

You can manipulate the information displayed in your reports using the Sort and Organize options. These features are accessed through the Data menu.

By default, all new reports are sorted by Zacks M (Medium) Industry.

Organize Report Options

An Organize option is used to classify companies in the report. Your report can be organized by

- Zacks X (Expanded) Industry
- Zacks X (Expanded) Sector
- Zacks (M) Medium Aggregate Industry

There are two more special options that allow two levels of organization:

- Organize by Zacks Expanded Sector and then by Expanded Industry designations
Organize by Zacks Expanded Sector and then by Medium Aggregate Industry designations
If you do not want to have your report organized, select None from the pull-down menu.

Organizing Reports
You can organize your reports before or after you run them. To organize a report, follow these steps:

1. From the Data menu, select the Organize/Sort command or click the Organize/Sort button. The Organize/Sort dialog box will be displayed.
2. From the Organize by pull-down menu, choose the desired organize option and click OK.
3. After organizing the report, you will be able to sort on up to three additional items. If you selected two levels of organization, you will be able to sort on up to two additional items.

Sorting Reports
You can sort your reports based on the contents of two or more columns. When you sort, the Research Wizard rearranges the report based on the sort order you specify. You can sort reports in ascending (1 to 9, A to Z) or descending (9 to 1, Z to A) order, based on the contents of one or more columns.

To sort the report, follow these steps:

1. From the Data menu, select the Organize/Sort command or click the Organize/Sort button. The Organize/Sort dialog box will be displayed.
2. Select the first sorting item in the Sort by box and the sort order – ascending or descending.
3. If the column you specify in the Sort by box has items that have identical values for several companies (example, Zacks Rank of 1), you can sort the values further by specifying another column in the first Then By box. If there are duplicate items in the second column, you can specify a third column to sort by in the second Then By box (the Research Wizard allows for sort on up to four items).
4. Click OK.

Running Existing Reports
To run an existing report, follow these steps:

1. From the Report menu, select the Open Report Definition command. The Report Definition dialog box will appear. (Saved reports usually appear in \ziir\inputs folder and have extension *.rpd).
2. Select a report and click OK. The Report Definition table will fill up.
3. Click Run Query to display the report.

The Research Wizard has several sample pre-formatted reports.
Adding/Removing Indices Options in Reports

By default, every report includes data for S&P 500, S&P Industrial, and DJIA Indices at the top of the report. You can add or remove these indices, by clicking *Indices* from the report output *Data* menu.

Adding Titles to Reports

To add title to your report, type the desired name in the provided report Title section at the report output menu (remember to save the report definition).
Working with Portfolios

Ticker List Overview

Research Wizard allows you to select and save group of tickers as a portfolio, called a Ticker List. A Ticker List is a text (tab-delimited) file that contains a column of ticker symbols. Research Wizard has a sample Ticker List - myportf.txt.

Creating Ticker Lists

Research Wizard works with special portfolio file called a Ticker List. A Ticker List is a text (tab-delimited) file with one column of data – companies’ tickers.

There are several ways you can create a Ticker List. You can save the companies that passed your screening criteria or you can manually enter the ticker symbols to the Ticker List.

To manually create a Ticker List, follow these steps:

1. From the Portfolio menu, select the Enter New Ticker List command or click the New Ticker List button. The Ticker List dialog box will appear.

   ![Ticker List dialog box.](image)

2. In the Ticker box, type a ticker symbol.
3. Click Add Ticker or press Enter.
4. To view the list of all available companies, use the scroll bar to browse the Full Universe selection. Select a company from the list and click << Add.
5. After all of your tickers have been entered, click Save As and then Apply to make the newly created Ticker List active.
Selecting Ticker Lists

To select a Ticker List, follow these steps:

1. From the Portfolio menu, select the Open Ticker List command or click the Open Ticker List button. The Ticker List dialog box will appear.
2. In the Look in box, click the drive and folder that contains the Ticker List.
3. In the folder list, double-click folders until you open the folder that contains the Ticker List you want. Double-click the Ticker List you want to open.

Editing Ticker List

Removing Tickers From Ticker List

To remove tickers from the list, follow these steps:

1. Open the Ticker List and then select the View/Edit Active Tickers command from the Portfolio menu, or click the View/Edit Ticker List button.
2. At the Ticker List dialog box, highlight a ticker on the Ticker List and click Remove.
3. To delete all ticker from the list, click Remove All.

Adding Tickers to Existing Ticker List

To add tickers to the existing Ticker List, follow these steps:

1. From the Portfolio menu, select the View/Edit Active Tickers command, or click the View/Edit Ticker List button.
2. At the Ticker List dialog, proceed with adding tickers to the list by entering them in the Ticker box.
3. After all of the tickers have been entered, click Save.

Combining Several Ticker Lists

To combine several Ticker Lists, follow these steps:

1. Open the first Ticker List and then select the View/Edit Active Tickers command from the Portfolio menu, or click the View/Edit Ticker List button. The Ticker List dialog box appears.
2. Click the Add List button.
3. In the Look in box, click the drive and folder that contains the Ticker List you want to add.
4. In the folder list, double-click the folders until you open the folder that contains the Ticker List you want.
5. Double-click the Ticker List you want to add.
6. The ticker lists will be combined.
Working with Calculation Expressions

Understanding Calculation Expression (User–Defined Calculations)

With the Research Wizard, you can create your own screening or reporting items using the Calculation Expression function. The Research Wizard provides a comprehensive set of operators and functions that you can use to create custom items and complex calculations.

To build a calculation for screening, select the Screen by Calculation Expression command from the Screen menu (alternatively, you can click the Screen by Calculation Expression button).

To use a calculation in the report, select the Add Calculation Expression command from the Report menu (alternatively, you can click the Add Calculation Expression button).

Building Calculation Expression Basics

The Calculation Expressions are built by selecting items, time periods, operators and functions from the corresponding menus of the Calculation Expression window. As you select items, operators, and functions and enter constants to build your expression, the formula for the expression will be displayed in the Calculation Expression data entry box.

There are two techniques for creating a calculation expression: the Direct Method (manually typing in the calculation expression) or using the Choose and Click Method.

For both options, the calculation expression is displayed in the Calculation Expression data entry box.
Creating Screening Calculation Expression

To create a screening calculated item, follow these steps:

1. From the **Screen** menu, select the **Screen By Calculation Expression** command or click the **Screen by Calculation Expression** button. The **Calculation Expression** window will appear.

2. Select (highlight) an item to be used in the calculation. If the item has several time periods, select the period from the pull-down menu. If you want to simply add the item, click the **Add Item** button. (If necessary, use additional operators).

   If you want to use a function, proceed to the Function Parameters selection and click **Select** (the item number and period will be shown).

3. Next, select (highlight) the desired Function Category and select the function from the menu. Some functions will have additional parameters that you will need to specify. Click the **Add Selected Function** button when done.

4. Enter the name for the calculated item in the entry box labeled **“Calculation Expression (referred in the report as)”**.

5. When the expression is complete, click **OK**. The **Screen By** dialog box will appear. Specify your screening criteria and click **OK**. The calculation expression will be added to the **Screening Criteria** table.

Using Calculation Expression in Reports

To add a calculated item to the report, follow these steps:

1. From the **Report** menu, select the **Add Calculation Expression** command or click the **Add Calculation Expression** button. The **Calculation Expression** window will appear.

2. Select (highlight) an item to be used in the calculation. If the item has several time periods, select the period from the pull-down menu. If you want to simply add the item, click the **Add Item** button. (If necessary, use additional operators). If you want to use a function, proceed to the Function Parameters selection and click **Select** (the item number and period will be shown).

3. Next, select (highlight) the desired Function Category and select the function from the menu. Some functions will have additional parameters that you will need to specify. Click the **Add Selected Function** button when done.

4. Enter the name for the calculated item in the entry box labeled **“Calculation Expression (referred in the report as)”**.

5. When the expression is complete, click **OK**. The calculated item will be added to the **Report Definition** table.
Changing Calculated Items Name in Screens

To rename a calculated item in the screen definition, follow these steps:

1. Open the screen definition. At the Screening Criteria table, right-click the calculated item to display the Edit menu. (Alternatively, you can double-click the item).

2. Select the Modify command. The Calculation Expression dialog box will appear.

3. Enter the name for the calculated item in the entry box labeled “Calculation Expression (referred in the report as)” and click OK. At the Screen by menu, enter your parameters and click OK.

4. Save the screen definition.

Changing Calculated Items Name in Reports

To rename a calculated item in the report definition, follow these steps:

1. Open the report definition. At the Report Definition table, right-click the calculated item to display the Edit menu. (Alternatively, you can double-click the item).

2. Select the Modify command. The Modify Column dialog box will appear.

3. At the Column Name section, type the item name using, if needed, two lines for the names (for example: Sales-to Average Working Capital). Click OK.

4. Save the report definition.

Calculation Expression Parameters

Overview

The maximum number of characters for a calculation expression is 500. The maximum number of operands/elements that can be used in a calculation expression is 60. The item name for a calculation expression is restricted to 10 characters.

Constants: Large numbers should be typed without commas: 1000000 instead of 1,000,000.

Lag (Date) - You may also lead or lag an item in your calculation expression. For example, you want to calculate 3 month relative price change using the month end close price (item 6, 13 months available) you create an
expression as \((i6 - i6[-3]) / i6[-3]\). The \(i6[-3]\) lags the month end close price \(i6\) by 3 months.

**Ticker** - Specifying a ticker in the Calculation Expression allows creation of the Relative Calculations.

### Calculation Expression Operator Categories

There are four Operator Categories in the Research Wizard:

1. **Arithmetic Operators:**
   - \(+\) – addition and subtraction
   - \(-\) – subtraction
   - \(*\) – multiplication
   - 

2. **Comparison Operators:**
   - \(>\) – Greater than
   - \(>=\) – Greater than or equal to
   - \(<\) – Less than
   - \(<=\) – Less than or equal to
   - \(=\) – Equal to
   - \(<>\) – Not equal to

3. **Logical Operators:**
   - **AND** returns TRUE if all its arguments are TRUE; returns FALSE if one or more arguments is FALSE.
   - **OR** returns TRUE if any argument is TRUE; returns FALSE if all arguments are FALSE.

4. **Miscellaneous Operators:**
   - \(^\) – Exponentiation operator. Exponentiation may be done in two ways: raising a database item to a specified power, or raising a specified constant to the power of an item.

An item raised to a user-specified power: \(i##^n\) would raise the value of item \#\# to the power \(n\). For example, the expression \(i5^2\), when item 5 is equal to 54.25, would be interpreted as \((54.25)^2\) and will produce 2,943.06.

A user-specified constant raised to the power of an item: \(n^i##\) would raise \(n\) to the value of item \#\#. For example, when the value of item 136 is equal to 2.19, the expression \(2^i136\) would be interpreted as \((2)^{2.19}\) and will produce 4.58.

| "SELECT" operator. To select alternative item for a calculation if a given item is N/A. Use the "Select" operator (\(<|>\), or \(<\text{Shift } + \text{ Backslash}>\)) as follows: \(i5\mid i6\). This expression will use the value of item 5 unless it is N/A, in which case it will use the value of item 6.

### Calculation Expression Function Categories

There are nine function categories available when building a calculation expression. They are:

**Math:** Use the following functions to manipulate or combine items:

- **Abs** – Calculates the absolute value (i.e. value without its sign).
- **Exp** – Calculates the value of a constant \(e\) raised to the specified
power.

- **LogN** – Calculates the natural logarithm.
- **Log10** – Calculates the base 10 logarithm.
- **Sqrt** – Calculates a square root.
- **Trun** – Truncates a data item value to the lowest integer by removing the decimal, or fractional, part of the number.

**Universe Aggregate**: Use this option to perform calculations using all companies in the Zacks database. Aggregate values may then be compared to individual values to create relative comparisons. N/A values are excluded from the calculations.

- **AllSum** – Calculates the Sum value for the selected item for all companies in the Full Universe.
- **AllMed** – Calculates the Median value for the selected item for all companies in the Full Universe.
- **AllMean** – Calculates the Mean value for the selected item for all companies in the Full Universe.
- **AllHi** – Calculates the highest value for the selected item for all companies in the Full Universe.
- **AllLo** – Calculates the lowest value for the selected item for all companies in the Full Universe.
- **AllStdDev** – Calculates the Standard Deviation for the selected item for all companies in the Full Universe.
- **AllMktWtAv** – Calculates the Market Weighted Average for the selected item for the companies in the Full Universe.

**S&P 500 Aggregate**: Use this option to calculate aggregate values of the data item for the companies in the S&P 500. N/A values are excluded from the calculations.

- **SPSum** – Calculates the Sum value for the selected item for the S&P 500.
- **SPMed** – Calculates the Median value for the selected item for the S&P 500.
- **SPMean** – Calculates the Mean value for the selected item for the S&P 500.
- **SPHi** – Calculates the highest value for the selected item for the S&P 500.
- **SPLo** – Calculates the lowest value for the selected item for the S&P 500.
- **SPStdDev** – Calculates the Standard Deviation for the selected item for the S&P 500.
- **SPMktWtAv** – Calculates the Market Weighted Average for the selected item for the S&P 500.

**XIndustry Aggregate**: Use this option to calculate aggregate values of the data item for the companies in Zacks X Industry. Aggregate values may then be compared to individual values to create relative comparisons. N/A values are excluded from the calculations.

- **XIndSum** – Calculates the Sum value for the selected item for the companies in the X Industry.
• **XIndMed** – Calculates the Median value for the selected item for the companies in the X Industry.

• **XIndMean** – Calculates the Mean value for the selected item for the companies in the X Industry.

• **XIndMktWtAv** – Calculates the Market Weighted Average for the companies in the X Industry.

• **XIndHi** – Calculates the highest value for the selected item for the companies in the X Industry.

• **XIndLo** – Calculates the lowest value for the selected item for the companies in the X Industry.

• **XIndNum** – Returns the Number of Companies in the Industry in the Full Universe.

• **XIndStdDev** – Calculates the Standard Deviation for the selected item for the companies in the X Industry.

**MIndustry Aggregate**: Use this option to calculate aggregate values of the data item for the companies in Zacks M Industry. Aggregate values may then be compared to individual values to create relative comparisons. N/A values are excluded from the calculations.

• **MIndSum** – Calculates the Sum value for the selected item for the companies in the M Industry.

• **MIndMed** – Calculates the Median value for the selected item for the companies in the M Industry.

• **MIndMean** – Calculates the Mean value for the selected item for the companies in the M Industry.

• **MIndMktWtAv** – Calculates the Market Weighted Average for the companies in the M Industry.

• **MIndHi** – Calculates the highest value for the selected item for the companies in the M Industry.

• **MIndLo** – Calculates the lowest value for the selected item for the companies in the M Industry.

• **MIndNum** – Returns the Number of Companies in the Industry in the Full Universe.

• **MIndStdDev** – Calculates the Standard Deviation for the selected item for the companies in the M Industry.

**Sector Aggregate**: Use this option to calculate aggregate values of the data item for the companies in Zacks X Sector. Aggregate values may then be compared to individual values to create relative comparisons. N/A values are excluded from the calculations.

• **SecSum** – Calculates the Sector Sum value for the companies in the X Sector.

• **SecMed** – Calculates the Sector Median value for the selected item for the companies in the X Sector.

• **SecMean** – Calculates the Sector Mean value for the selected item for the companies in the X Sector.

• **SectMktWtAv** – Calculates the Market Weighted Average for the selected item for the companies in the X Sector.

• **SeCHi** – Calculates the highest value for the selected item for the companies in the X Sector.
- **SecLo** – Calculates the lowest value for the selected item for the companies in the X Sector.
- **SecNum** – Returns the Number of Companies in the Industry in the X Sector.
- **SecStdDev** – Calculates the Standard Deviation for the selected item for the companies in the X Sector.

**Rank:** Classify companies within the full universe or corresponding Zacks Sector, X or M Industry.
- **AllOrdRank** – Classifies companies in the Full Universe using Ordinal Rank.
- **AllHstRank** – Classifies companies in the Full Universe using Histogram Rank.
- **AllUnRank** – Classifies companies in the Full Universe using Uniform Rank.
- **XIndOrdRank** – Classifies companies in the X Industry using Ordinal Rank.
- **XIndHstRank** – Classifies companies in the X Industry using Histogram Rank.
- **XIndUnRank** – Classifies companies in the X Industry using Uniform Rank.
- **MIndOrdRank** – Classifies companies in the M Industry using Ordinal Rank.
- **MIndHstRank** – Classifies companies in the M Industry using Histogram Rank.
- **MIndUnRank** – Classifies companies in the M Industry using Uniform Rank.
- **SecOrdRank** – Classifies companies in the Sector using Ordinal Rank.
- **SecHstRank** – Classifies companies in the Sector using Histogram Rank.
- **SecUnRank** – Classifies companies in the Sector using Uniform Rank.

**Moving Average:** Use this option to perform the following functions:
- **MovingSum** – Calculate the sum of the values over the specified period for the data item.
- **MovingMean** – Calculate the mean value over the specified period for the data item.
- **MovingLo** – Calculate the lowest value for the specified period for the data item.
- **MovingHi** – Calculate the highest value for the specified period for the data item.

**Miscellaneous:** Use this option to perform the following:
- **ChkNA** – Produces 0 if item has N/A or 1 if item is not N/A.
- **NaTo0 (item)** – Shows a value of the item when item is not N/A. If the item is a N/A, show 0.
- **FiscM (i2)** – Creates calculations using fiscal year end month.
• **FiscD** (i2) – Creates calculations using day in the fiscal year.

**Custom Aggregates/Ranks:** Use this option to perform the following:
- **AllAgg** – Allows to select a certain aggregate for the full universe.
- **AllWtAv** – Calculate a Weighted Average for all companies in the database universe using any specific item.
- **GrAgg** – Calculate a Group–specific aggregate.
- **SpGrAgg** – Calculate special aggregates for Group.
- **GrOrdRank** – Calculate Ordinal Rank in Group.
- **GrUnRank** – Calculate Uniform Rank in Group.
- **GrHstRank** – Calculate Histogram Rank in Group.

**Calculation Expression: Math**

**Using Math Functions in Screening Calculation Expression**

To create a screening calculation expression using the Math function, follow these steps:

1. From the **Screen** menu, select the Screen By Calculation Expression command or click the **Screen by Calculation Expression** button. The **Calculation Expression** window will appear.

2. Select (highlight) the item to be used in the calculation. When the selected item has more than one period of data, you can also select a specific time period from the time period pull-down menu (above the **Add Item** button).

3. At the Function Parameters menu, click the **<-Select** button. The selected item's number and time period will appear in the Function parameters data boxes.

4. From the Function Category list, click **Math**.

5. From the Function Name list, select the desired Math function (Example: Abs – Absolute Value) and double-click that function name or click the **Add Selected Function** button.

   The calculation expression will appear in the **Calculation Expression** data entry box (Example: Abs( i41[06/2000]).

6. Enter the name for the calculated item in the entry box labeled "**Calculation Expression (referred in the report as)**".

7. Click **OK**. The **Screen** by dialog box will appear.

8. Specify the screening parameters and click **OK**. The Calculation Expression will be added to the **Screening Criteria** table.
Adding Calculation Expression to Reports: Math

To add a calculated item to the report using the Math function, follow these steps:

1. From the Report menu, select the Add Calculation Expression command or click the Add Calculation Expression button. The Calculation Expression dialog box will be displayed.

2. Select (highlight) the item to be used in the calculation. When the selected item has more than one period of data, you can also select a specific time period from the time period pull-down menu (above the Add Item button).

3. At the Function Parameters menu, click the <Select button. The selected item’s number and time period will appear in the Function parameters data boxes.

4. From the Function Category list, click Math.

5. From the Function Name list, select the desired Math function and double click that function name or click the Add Selected Function button. The calculation expression will appear in the Calculation Expression data entry box.

6. Enter the name for the calculated item in the entry box labeled “Calculation Expression (referred in the report as)”.

7. Click OK.

8. The Calculation Expression will be added to the Report Definition table.

Available Math Functions

- **Absolute Value**: Calculates the absolute value of an item (i.e. without its sign). This function may be applied to a data item, constant or an expression.
  
  Example a:  $\text{Abs}(i122)$, when item 122 is –4.69, will be 4.69.
  
  Example b:  $5 \times \text{Abs}(i122)$, when item 122 is –4.69, will multiply 5 by the absolute value of item 122 and will be equal to 23.45.
  
  Example c: $\text{Abs}(i122/2)$, when item 122 is –4.69, will be 2.35.

- **Exponential Function** or $e^x$: Calculates the value of a constant $e$ ($2.71828$) raised to the power of $x$. This function may be applied to a data item, constant or an expression.
  
  Example:  $\text{Exp}(i80)$, when the value of item 80 is 3 will produce the value of 20.09 ($2.71828$ raised to the third power).

- **Natural Logarithm** or $\ln x$: Calculates the natural (Naperian, or base $e$) logarithm of a data item. This function may be applied to a data item, constant or an expression.
  
  Example:  $\text{LogN}(i5)$, when item 5 is 76.06 will be 4.33.

- **Base 10 Logarithm**: Calculates the base 10 logarithm of a number. This function may be applied to a data item, constant or an expression.
Example: Log10(i5), when item 5 is 76.06 will be 1.88.

- **Square Root**: Calculates a square root. This function may be applied to a data item, constant or an expression.
  Example: Sqrt(i5), when item 5 is 76.06 will be 8.72.

- **Trun**: Truncates a data item value to the lowest integer by removing the decimal, or fractional, part of the number.
  Example: Trun(i136), when item 136 is 1.925 will produce 1.

**Calculation Expression: Universe Aggregate**

**Using Universe Aggregate Functions in Screening Calculation Expression**

To create a screening calculation expression using the Universe Aggregate function, follow these steps:

1. From the **Screen** menu, select the Screen By Calculation Expression command or click the **Screen by Calculation Expression** button. The **Calculation Expression** window will appear.

2. Select (highlight) the item to be used in the calculation. When the selected item has more than one period of data, you can also select a specific time period from the time period pull-down menu (above the **Add Item** button).

3. At the Function Parameters menu, click the **<Select** button. The selected item's number and time period will appear in the Function parameters data boxes.

4. From the Function Category list, select the Universe Aggregate category.

5. Next, select the desired Universe Aggregate function from the Function Name list and double-click that function name or click the **Add Selected Function** button. The calculation expression will appear in the **Calculation Expression** data entry box.

6. Enter the name for the calculated item in the entry box labeled “**Calculation Expression** (referred in the report as)”.

7. Click **OK**. The **Screen by** dialog box will appear.

8. Specify the screening parameters and click **OK**. The Calculation Expression will be added to the **Screening Criteria** table.

**Adding Calculation Expression to Reports: Universe Aggregate**

To add a calculated item to the report using the Universe Aggregate function, follow these steps:
1. From the Report menu, select the Add Calculation Expression command or click the Add Calculation Expression button. The Calculation Expression dialog box will be displayed.

2. Select (highlight) the item to be used in the calculation. When the selected item has more than one period of data, you can also select a specific time period from the time period pull-down menu (above the Add Item button).

3. At the Function Parameters menu, click the <-Select button. The selected item’s number and time period will appear in the Function parameters data boxes.

4. From the Function Category list, select the Universe Aggregate category.

5. Next, select the desired Universe Aggregate function from the Function Name list and double-click that function name or click the Add Selected Function button. The calculation expression will appear in the Calculation Expression data entry box.

6. Enter the name for the calculated item in the entry box labeled "Calculation Expression (referred in the report as)".

7. Click OK.

8. The Calculation Expression will be added to the Report Definition table.

Available Universe Aggregate Functions

- **AllSum** – Calculates the Sum value for the selected item for all companies in the Full Universe.
- **AllMed** – Calculates the Median value for the selected item for all companies in the Full Universe.
- **AllMean** – Calculates the Mean value for the selected item for all companies in the Full Universe.
- **AllHi** – Calculates the highest value for the selected item for all companies in the Full Universe.
- **AllLo** – Calculates the lowest value for the selected item for all companies in the Full Universe.
- **AllStdDev** – Calculates the Standard Deviation for the selected item for all companies in the Full Universe.
- **AllMktWtAv** – Calculates the Market Weighted Average for the selected item for the companies in the Full Universe.

**Calculation Expression: S&P 500 Aggregate**

Using S&P 500 Aggregate Functions in Screening Calculation Expression

To create a screening calculation expression using the S&P 500 Aggregate function, follow these steps:
1. From the **Screen** menu, select the **Screen By Calculation Expression** command or click the **Screen by Calculation Expression** button. The **Calculation Expression** window will appear.

2. Select (highlight) the item to be used in the calculation. When the selected item has more than one period of data, you can also select a specific time period from the time period pull-down menu (above the **Add Item** button).

3. At the Function Parameters menu, click the **<-Select** button. The selected item's number and time period will appear in the Function parameters data boxes.

4. From the Function Category list, select the S&P 500 Aggregate category.

5. Next, select the desired S&P 500 Aggregate function from the Function Name list and double-click that function name or click the **Add Selected Function** button. The calculation expression will appear in the **Calculation Expression** data entry box.

6. Enter the name for the calculated item in the entry box labeled "**Calculation Expression (referred in the report as)**".

7. Click **OK**. The **Screen by** dialog box will appear.

8. Specify the screening parameters and click **OK**. The Calculation Expression will be added to the **Screening Criteria** table.

**Adding Calculation Expression to Reports: S&P 500 Aggregate**

To add a calculated item to the report using the S&P 500 Aggregate function, follow these steps:

1. From the **Report** menu, select the **Add Calculation Expression** command or click the **Add Calculation Expression** button. The **Calculation Expression** dialog box will be displayed.

2. Select (highlight) the item to be used in the calculation. When the selected item has more than one period of data, you can also select a specific time period from the time period pull-down menu (above the **Add Item** button).

3. At the Function Parameters menu, click the **<-Select** button. The selected item's number and time period will appear in the Function parameters data boxes.

4. From the Function Category list, select the S&P 500 Aggregate category.

5. Next, select the desired S&P 500 Aggregate function from the Function Name list and double-click that function name or click the **Add Selected Function** button. The calculation expression will appear in the **Calculation Expression** data entry box.

6. Enter the name for the calculated item in the entry box labeled "**Calculation Expression (referred in the report as)**".
7. Click OK.
8. The Calculation Expression will be added to the Report Definition table.

Available S&P 500 Aggregate Functions
- **SPSum** – Calculates the Sum value for the selected item for the S&P 500.
- **SPMed** – Calculates the Median value for the selected item for the S&P 500.
- **SPMean** – Calculates the Mean value for the selected item for the S&P 500.
- **SPHi** – Calculates the highest value for the selected item for the S&P 500.
- **SPLo** – Calculates the lowest value for the selected item for the S&P 500.
- **SPStdDev** – Calculates the Standard Deviation for the selected item for the S&P 500.
- **SPMktWtAv** – Calculates the Market Weighted Average for the selected item for the S&P 500.

Calculation Expression: X Industry Aggregate

Using X Industry Aggregate Functions in Screening Calculation Expression

To create a screening calculation expression using the X Industry Aggregate function, follow these steps:

1. From the Screen menu, select the Screen By Calculation Expression command or click the Screen by Calculation Expression button. The CalculationExpression window will appear.
2. Select (highlight) the item to be used in the calculation. When the selected item has more than one period of data, you can also select a specific time period from the time period pull-down menu (above the Add Item button).
3. At the Function Parameters menu, click the <Select button. The selected item’s number and time period will appear in the Function parameters data boxes.

<table>
<thead>
<tr>
<th>Function Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Item #, Date</td>
</tr>
<tr>
<td>41</td>
</tr>
<tr>
<td>06/2000</td>
</tr>
<tr>
<td>&lt;Select&gt;</td>
</tr>
</tbody>
</table>

4. Select the X Industry Aggregate category from the Function Category list and then desired aggregated from the Function Name list and click the Add Selected Function button. The calculation expression will appear in the Calculation Expression data entry box.
5. Enter the name for the calculated item in the entry box labeled “Calculation Expression (referred in the report as)”.
6. Click OK. The Screen by dialog box will appear.

7. Specify the screening parameters and click OK. The Calculation Expression will be added to the Screening Criteria table.

Adding Calculation Expression to Reports: X Industry Aggregate

To add a calculated item to the report using the X Industry Aggregate functions, follow these steps:

1. From the Report menu, select the Add Calculation Expression command or click the Add Calculation Expression button. The Calculation Expression dialog box will be displayed.

2. Select (highlight) the item to be used in the calculation. When the selected item has more than one period of data, you can also select a specific time period from the time period pull-down menu (above the Add Item button).

3. At the Function Parameters menu, click the <Select button. The selected item's number and time period will appear in the Function parameters data boxes.

4. Select the X Industry Aggregate category from the Function Category list and then desired aggregated from the Function Name list and click the Add Selected Function button. The calculation expression will appear in the Calculation Expression data entry box.

5. Enter the name for the calculated item in the entry box labeled “Calculation Expression (referred in the report as)”.

6. Click OK.

7. The Calculation Expression will be added to the Report Definition table.

Available X Industry Aggregate Functions

- **XIndSum** – Calculates the Sum value for the selected item for the companies in the X Industry.
- **XIndMed** – Calculates the Median value for the selected item for the companies in the X Industry.
- **XIndMean** – Calculates the Mean value for the selected item for the companies in the X Industry.
- **XIndMktWtAv** – Calculates the Market Weighted Average for the selected item for the companies in the X Industry.
- **XIndHi** – Calculates the highest value for the selected item for the companies in the X Industry.
- **XIndLo** – Calculates the lowest value for the selected item for the companies in the X Industry.
- **XIndNum** – Returns the Number of Companies in the Industry in the Full Universe.
• **XIndStdDev** – Calculates the Standard Deviation for the selected item for the companies in the X Industry.

**Calculation Expression: M Industry Aggregate**

**Using M Industry Aggregate Functions in Screening Calculation Expression**

To create a screening calculation expression using the M Industry Aggregate function, follow these steps:

1. From the **Screen** menu, select the Screen By Calculation Expression command or click the **Screen by Calculation Expression** button. The **Calculation Expression** window will appear.

2. Select (highlight) the item to be used in the calculation. When the selected item has more than one period of data, you can also select a specific time period from the time period pull-down menu (above the **Add Item** button).

3. At the Function Parameters menu, click the **<Select** button. The selected item's number and time period will appear in the Function parameters data boxes.

4. Select the M Industry Aggregate category from the Function Category list.

5. Select the desired aggregate from the Function Name list and click the **Add Selected Function** button. The calculation expression will appear in the **Calculation Expression** data entry box.

6. Enter the name for the calculated item in the entry box labeled “**Calculation Expression (referred in the report as)**”.

7. Click **OK**. The **Screen by** dialog box will appear.

8. Specify the screening parameters and click **OK**. The Calculation Expression will be added to the **Screening Criteria** table.

**Adding Calculation Expression to Reports: M Industry Aggregate**

To add a calculated item to the report using the M Industry Aggregate functions, follow these steps:

1. From the **Report** menu, select the Add Calculation Expression command or click the **Add Calculation Expression** button. The **Calculation Expression** dialog box will be displayed.

2. Select (highlight) the item to be used in the calculation. When the selected item has more than one period of data, you can also select a specific time period from the time period pull-down menu (above the **Add Item** button).
3. At the Function Parameters menu, click the <Select button. The selected item's number and time period will appear in the Function parameters data boxes.

4. Select the M Industry Aggregate category from the Function Category list.

5. Select the desired aggregate from the Function Name list and click the Add Selected Function button. The calculation expression will appear in the Calculation Expression data entry box.

6. Enter the name for the calculated item in the entry box labeled “Calculation Expression (referred in the report as)”.

7. Click OK.

8. The Calculation Expression will be added to the Report Definition table.

Available M Industry Aggregate Functions

- **MIndSum** – Calculates the Sum value for the selected item for the companies in the M Industry.
- **MIndMed** – Calculates the Median value for the selected item for the companies in the M Industry.
- **MIndMean** – Calculates the Mean value for the selected item for the companies in the M Industry.
- **MIndMktWtAv** – Calculates the Market Weighted Average for the selected item for the companies in the M Industry.
- **MIndHi** – Calculates the highest value for the selected item for the companies in the M Industry.
- **MIndLo** – Calculates the lowest value for the selected item for the companies in the M Industry.
- **MIndNum** – Returns the Number of Companies in the Industry in the Full Universe.
- **MIndStdDev** – Calculates the Standard Deviation for the selected item for the companies in the M Industry.

**Calculation Expression: Sector Aggregate**

**Using Sector Aggregate Functions in Screening Calculation Expression**

To create a screening calculation expression using the Sector Aggregate function, follow these steps:

1. From the Screen menu, select the Screen By Calculation Expression command or click the Screen by Calculation Expression button. The Calculation Expression window will appear.
2. Select (highlight) the item to be used in the calculation. When the selected item has more than one period of data, you can also select a specific time period from the time period pull-down menu (above the Add Item button).

3. At the Function Parameters menu, click the <<Select button. The selected item's number and time period will appear in the Function parameters data boxes.

4. Select the Sector Aggregate category from the Function Category list.

5. Select the desired aggregate from the Function Name list and click the Add Selected Function button. The calculation expression will appear in the Calculation Expression data entry box.

6. Enter the name for the calculated item in the entry box labeled “Calculation Expression (referred in the report as)”.

7. Click OK. The Screen by dialog box will appear.

8. Specify the screening parameters and click OK. The Calculation Expression will be added to the Screening Criteria table.

**Adding Calculation Expression to Reports: Sector Aggregates**

To add a calculated item to the report using the Sector Aggregate Functions:

1. From the Report menu, select the Add Calculation Expression command or click the Add Calculation Expression button. The Calculation Expression dialog box will be displayed.

2. Select (highlight) the item to be used in the calculation. When the selected item has more than one period of data, you can also select a specific time period from the time period pull-down menu (above the Add Item button).

3. At the Function Parameters menu, click the <<Select button. The selected item's number and time period will appear in the Function parameters data boxes.

4. Select the desired aggregate from the Function Name list and click the Add Selected Function button. The calculation expression will appear in the Calculation Expression data entry box.

5. Enter the name for the calculated item in the entry box labeled “Calculation Expression (referred in the report as)”.

6. Click OK.

7. The Calculation Expression will be added to the Report Definition table.
Available Sector Aggregate Functions

- **SecSum** – Calculates the Sector Sum value for the companies in the X Sector.
- **SecMed** – Calculates the Sector Median value for the selected item for the companies in the X Sector.
- **SecMean** – Calculates the Sector Mean value for the selected item for the companies in the X Sector.
- **SectMktWtAv** – Calculates the Market Weighted Average for the selected item for the companies in the X Sector.
- **SecHi** – Calculates the highest value for the selected item for the companies in the X Sector.
- **SecLo** – Calculates the lowest value for the selected item for the companies in the X Sector.
- **SecNum** – Returns the Number of Companies in the Industry in the X Sector.
- **SecStdDev** – Calculates the Standard Deviation for the selected item for the companies in the X Sector.

Calculation Expression: Rank

**Overview**

Ranking functions allow you to classify companies within the full universe or corresponding sector or industry.

The ordinal ranking algorithm will rank items by their values, based on the number of tickers in the group.

The uniform ranking algorithm will place approximately equal numbers of companies in each fractile. If there are several fractiles of companies with the same value for the variable selected, they will be assigned a rank in the middle of the range they would otherwise fill.

The histogram ranking algorithm will create equal-length intervals based on high and low values within each time period. Histogram ranking shows the distribution of values on a selected item. If an item has a wide range of values with a number of “outliers” this ranking method will have small numbers of companies in the top and bottom ranking, and a large number of companies in each of the middle ranks.

N/A values are not assigned a rank, but receive a N/A rank.

Using Rank Functions: Ordinal Ranking in Screening Calculation Expression

To create a screening calculation expression using the Ordinal Rank function, follow these steps:

1. From the Screen menu, select the Screen By Calculation Expression command or click the Screen by Calculation Expression button. The Calculation Expression window will appear.
2. Select (highlight) the item to be used in the calculation. When the selected item has more than one period of data, you can also select a
specific time period from the time period pull-down menu (above the **Add Item** button).

3. At the Function Parameters menu, click the **<Select** button. The selected item's number and time period will appear in the Function parameters data boxes.

![Function Parameters](image)

4. From the Function Category list click Rank and then select the desired Ordinal ranking (Full Universe, Industry or Sector) from the Function Name list.

5. At the Additional Parameters menu, select a ranking order (ascending or descending) from the Rank Order pull-down menu.

![Additional Parameters](image)

6. Click the **Add Selected Function** button to add the expression to the Expression Calculation box.

7. Enter the name for the calculated item in the entry box labeled *Calculation Expression (referred in the report as)*.

![Calculation Expression](image)

8. Click **OK**. The Screen by dialog box will appear.

9. Specify the screening parameters and click **OK**. The Calculation Expression will be added to the Screening Criteria table.

**Adding Calculation Expression to Reports: Ordinal Ranking**

To add a calculated item to the report using the Ordinal Ranking, follow these steps:

1. From the **Report** menu, select the Add Calculation Expression command or click the **Add Calculation Expression** button. The Calculation Expression dialog box will be displayed.

2. Select (highlight) the item to be used in the calculation. When the selected item has more than one period of data, you can also select a specific time period from the time period pull-down menu (above the **Add Item** button).

3. At the Function Parameters menu, click the **<Select** button. The selected item's number and time period will appear in the Function parameters data boxes.
4. From the Function Category list click Rank and then select the desired Ordinal ranking (Full Universe, Industry or Sector) from the Function Name list.

5. At the Additional Parameters menu, select a ranking order (ascending or descending) from the Rank Order pull-down menu.

6. Click the Add Selected Function button to add the expression to the Expression Calculation box.

7. Enter the name for the calculated item in the entry box labeled "Calculation Expression (referred in the report as)".

8. Click OK.

9. The Calculation Expression will be added to the Report Definition table.

Using Rank Functions: Uniform or Histogram Ranking in Screening Calculation Expression

To create a screening calculation expression using either Uniform or Histogram Ranking, follow these steps:

1. From the Screen menu, select the Screen By Calculation Expression command or click the Screen by Calculation Expression button. The Calculation Expression window will appear.

2. Select (highlight) the item to be used in the calculation. When the selected item has more than one period of data, you can also select a specific time period from the time period pull-down menu (above the Add Item button).

3. At the Function Parameters menu, click the Select button. The selected item's number and time period will appear in the Function parameters data boxes.

4. From the Function Category list click Rank and then select the desired Uniform or Histogram ranking (Full Universe, Industry or Sector) from the Function Name list.

5. At the Additional Parameters menu, select a ranking order (ascending or descending) from the Rank Order pull-down menu and type the number.
of fractiles (default is 10) into which item’s values will be ranked (e.g., 5 for quintiles, 10 for deciles, and so on) in the corresponding Number of Fractiles box.

6. Click the Add Selected Function button to add the expression to the Expression Calculation box.

7. Enter the name for the calculated item in the entry box labeled “Calculation Expression (referred in the report as)”.

8. Click OK. The Screen by dialog box will appear.

9. Specify the screening parameters and click OK. The Calculation Expression will be added to the Screening Criteria table.

Adding Calculation Expression to Reports: Uniform or Histogram Ranking

To add a calculated item to the report using Uniform or Histogram Ranking, follow these steps:

1. From the Report menu, select the Add Calculation Expression command or click the Add Calculation Expression button. The Calculation Expression dialog box will be displayed.

2. Select (highlight) the item to be used in the calculation. When the selected item has more than one period of data, you can also select a specific time period from the time period pull-down menu (above the Add Item button).

3. At the Function Parameters menu, click the <Select button. The selected item’s number and time period will appear in the Function parameters data boxes.

4. From the Function Category list click Rank and then select the desired Uniform or Histogram ranking (Full Universe, Industry or Sector) from the Function Name list.

5. At the Additional Parameters menu, select a ranking order (ascending or descending) from the Rank Order pull-down menu and type the number of fractiles (default is 10) into which item’s values will be ranked (e.g., 5 for quintiles, 10 for deciles, and so on) in the corresponding Number of Fractiles box.
6. Click the **Add Selected Function** button to add the expression to the Expression Calculation box.

7. Enter the name for the calculated item in the entry box labeled “**Calculation Expression (referred in the report as)**”.

8. Click **OK**.

9. The Calculation Expression will be added to the **Report Definition** table.

### Available Rank Functions

- **AllOrdRank** – Classifies companies in the Full Universe using Ordinal Rank.
- **AllHstRank** – Classifies companies in the Full Universe using Histogram Rank.
- **AllUnRank** – Classifies companies in the Full Universe using Uniform Rank.
- **XIndOrdRank** – Classifies companies in the X Industry using Ordinal Rank.
- **XIndHstRank** – Classifies companies in the X Industry using Histogram Rank.
- **XIndUnRank** – Classifies companies in the X Industry using Uniform Rank.
- **MIndOrdRank** – Classifies companies in the M Industry using Ordinal Rank.
- **MIndHstRank** – Classifies companies in the M Industry using Histogram Rank.
- **MIndUnRank** – Classifies companies in the M Industry using Uniform Rank.
- **SecOrdRank** – Classifies companies in the Sector using Ordinal Rank.
- **SecHstRank** – Classifies companies in the Sector using Histogram Rank.
- **SecUnRank** – Classifies companies in the Sector using Uniform Rank.

### Selecting Ranking Order

When specifying your ranking method, you will be asked to select the ranking order: Ascending or Descending. This selection will specify whether the highest numerical value of the ranked item will be ranked highest (ascending order) or lowest (descending order). For example, an ascending order rank...
of raw values 47 and 44 might be “10” and “9” respectively. A descending-order rank would assign 47 a “1” and 44 a “2”.

In Research Wizard, there is an assumption that 1 is the best Rank. The descending order will assign low rank numbers to high values. Ascending order will assign low ranks to low values.

**Example: Rank on Market Value**

<table>
<thead>
<tr>
<th>Company</th>
<th>Market Cap ($mil)</th>
<th>Ordinal Descending</th>
<th>Histogram Descending (Decile)</th>
<th>Uniform Descending (Decile)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Company A</td>
<td>$82,798</td>
<td>1</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>Company B</td>
<td>$56,098</td>
<td>2</td>
<td>4</td>
<td>1</td>
</tr>
<tr>
<td>Company C</td>
<td>$53,640</td>
<td>3</td>
<td>4</td>
<td>2</td>
</tr>
<tr>
<td>Company D</td>
<td>$13,715</td>
<td>4</td>
<td>9</td>
<td>3</td>
</tr>
<tr>
<td>Company E</td>
<td>$6,297</td>
<td>5</td>
<td>10</td>
<td>4</td>
</tr>
<tr>
<td>Company F</td>
<td>$1,063</td>
<td>6</td>
<td>10</td>
<td>5</td>
</tr>
<tr>
<td>Company G</td>
<td>$626</td>
<td>7</td>
<td>10</td>
<td>6</td>
</tr>
<tr>
<td>Company H</td>
<td>$58</td>
<td>8</td>
<td>10</td>
<td>6</td>
</tr>
<tr>
<td>Company I</td>
<td>$48</td>
<td>9</td>
<td>10</td>
<td>7</td>
</tr>
<tr>
<td>Company J</td>
<td>$41</td>
<td>10</td>
<td>10</td>
<td>8</td>
</tr>
<tr>
<td>Company K</td>
<td>$34</td>
<td>11</td>
<td>10</td>
<td>9</td>
</tr>
<tr>
<td>Company L</td>
<td>$32</td>
<td>12</td>
<td>10</td>
<td>10</td>
</tr>
</tbody>
</table>

Carefully specify your ranking order when working with the items for which the low values are “better” than the higher ones. For example, Broker Ratings will range from 1 – Strong Buy to 5 – Strong Sell.

**Calculation Expression: Moving Average**

**Using Moving Functions in Screening Calculation Expression**

To create a screening calculation expression using the Moving function, follow these steps:

1. From the **Screen** menu, select the Screen By Calculation Expression command or click the **Screen by Calculation Expression** button. The **Calculation Expression** window will appear.

2. Select (highlight) the item to be used in the calculation. When the selected item has more than one period of data, you can also select a specific time period from the time period pull-down menu (above the **Add Item** button).

3. At the Function Parameters menu, click the **Select** button. The selected item’s number and time period will appear in the Function parameters data boxes.
4. From the Function Category list, click Moving Average and then select
the desired function from the Function Name list.

5. At the Additional Parameters menu, select type the number of periods to
be used in the moving calculation in the Number of Intervals box.

6. Click the **Add Selected Function** button to add the expression to the
Expression Calculation box.

7. Enter the name for the calculated item in the entry box labeled
“**Calculation Expression (referred in the report as)**”.

8. Click OK.

9. The **Screen by** dialog box will appear. Specify the screening parameters
and click OK. The Calculation Expression will be added to the
**Screening Criteria** table.

### Adding Calculation Expression to Reports: Moving Functions

To add a calculated item to the report using the Moving Average Function,
follow these steps:

1. From the **Report** menu, select the Add Calculation Expression command
or click the **Add Calculation Expression** button. The **Calculation Expression** dialog box will be displayed.

2. Select (highlight) the item to be used in the calculation. When the
selected item has more than one period of data, you can also select a
specific time period from the time period pull-down menu (above the **Add Item** button).

3. At the Function Parameters menu, click the <-**Select** button. The
selected item’s number and time period will appear in the Function
parameters data boxes.

4. From the Function Category list, click Moving Average and then select
the desired function from the Function Name list.
5. At the Additional Parameters menu, select type the number of periods to be used in the moving calculation in the Number of Intervals box.

6. Click the Add Selected Function button to add the expression to the Expression Calculation box.

7. Enter the name for the calculated item in the entry box labeled “Calculation Expression (referred in the report as)”.

8. Click OK.

9. The Calculation Expression will be added to the Report Definition table.

Available Moving Functions

There are several moving transformations available:

- **The Moving Sum**: Calculates the sum of the values in the specified period for the data item. Example: MovingSum5(i6), when item 6 has the following values for the specified five periods: 71, 59.88, 69.31, 65.94, 69.38, will produce 335.51. Usable for items with multiple periods only.

- **The Moving Mean**: Calculates the mean value over the specified periods for the data item. Example: MovingMean5(i6), when item 6 has the following values for the specified five periods: 71, 59.88, 69.31, 65.94, 69.38, will produce 67.1 as their mean. Usable for items with multiple periods only.

- **The Moving High**: Calculates the highest value for the specified periods for the data item. Example: MovingHi5(i6), when item 6 has the following values for the specified five periods: 71, 59.88, 69.31, 65.94, 69.38, will produce 71 – the highest value over the five periods. Usable for items with multiple periods only.

- **The Moving Low**: Calculates the lowest value for the specified periods for the data item. Example: MovingLo5(i6), when item 6 has the following values for the specified five periods: 71, 59.88, 69.31, 65.94, 69.38, will produce 59.88 – the lowest value over the five periods. Usable for items with multiple periods only.

Calculation Expression: Miscellaneous

Using Miscellaneous Functions in Screening Calculation Expression

To create a screening calculation expression using the Miscellaneous function, follow these steps:
1. From the **Screen** menu, select the **Screen By Calculation Expression** command or click the **Screen by Calculation Expression** button. The **Calculation Expression** window will appear.

2. Select (highlight) the item to be used in the calculation. When the selected item has more than one period of data, you can also select a specific time period from the time period pull-down menu (above the **Add Item** button).

3. At the Function Parameters menu, click the **<-Select** button. The selected item's number and time period will appear in the Function parameters data boxes.

4. From the Function Category list, select the Miscellaneous category.

5. Next, select the desired Miscellaneous function from the Function Name list and double-click that function or click the **Add Selected Function** button. The Calculation Expression will appear in the Calculation Expression data entry box.

6. Enter the name for the calculated item in the entry box labeled "**Calculation Expression** (referred in the report as)".

7. Click **OK**. The **Screen by** dialog box will appear.

8. Specify the screening parameters and click **OK**. The Calculation Expression will be added to the **Screening Criteria** table.

**Adding Calculation Expression to Reports: Miscellaneous Functions**

To add a calculated item to the report using the Miscellaneous Functions, follow these steps:

1. From the **Report** menu, select the **Add Calculation Expression** command or click the **Add Calculation Expression** button. The **Calculation Expression** dialog box will be displayed.

2. Select (highlight) the item to be used in the calculation. When the selected item has more than one period of data, you can also select a specific time period from the time period pull-down menu (above the **Add Item** button).

3. At the Function Parameters menu, click the **<-Select** button. The selected item's number and time period will appear in the Function parameters data boxes.

4. From the Function Category list, select the Miscellaneous category.
5. Next, select the desired Miscellaneous function from the Function Name list and double-click that function or click the Add Selected Function button. The Calculation Expression will appear in the Calculation Expression data entry box.

6. Enter the name for the calculated item in the entry box labeled “Calculation Expression (referred in the report as)”.

7. Click OK.

8. The Calculation Expression will be added to the Report Definition table.

Available Miscellaneous Functions

- **Fiscal Month** (FiscM): Allows you to create calculations using the fiscal year end month. Could be used in creating time-weighted calculations.

  Example: \(((12 - \text{FiscM}(i2))*i49 + \text{FiscM}(i2)*(i59|i49)) / 12\) will create a Time Weighted 12 Month Forward Looking Estimate, where item 49 is \(F(1)\) Consensus Estimate ($/share) and item 59 is \(F(2)\) Consensus Estimate ($/share).

- **Fiscal Day** (FiscD): Allows you to create calculations using the number of days into the company's fiscal year. Could be used in creating time-weighted calculations.

  Example: \(((365-\text{FiscD}(i2))*i49+\text{FiscD}(i2)*(i59|i49))/365\) will create a Time Weighted 12 Month Forward Looking Estimate, where item 49 is \(F(1)\) Consensus Estimate ($/share) and item 59 is \(F(2)\) Consensus Estimate ($/share).

- **Check N/A**: Allows you to select or display all tickers in your active universe with N/A's for a given data item; this operation produces 0 if item has N/A or 1 if item is not N/A.

  Example: ChkNA( i41), when item 41 has a value for ticker A as 5% and value for ticker B as N/A for the specified period, this operation will assign 0 for ticker B and 1 for ticker A.

- **Convert N/A to 0**: Converts an NA data point to a 0 value. Shows a value of the item when item is not N/A. If the item is a N/A it will show 0.

  Example: NaTo0( i41), when item 41 has a value for ticker A as 5% and value for ticker B as N/A for the specified period, this operation will assign 0 for ticker B and 5% for ticker A.

**Calculation Expression: Custom Aggregates/Ranks**

**Using Custom Aggregates/Ranks Functions in Screening Calculation Expression**

The Custom Aggregates/Ranks functions is a group of special functions that allow users to use any item as the basis for aggregation or ranking. It also allows to use any item as the Weight or Rank Item.

To create a screening calculation expression using the Custom Aggregates/Ranks function, follow these steps:

1. From the Screen menu, select the Screen By Calculation Expression command or click the Screen by Calculation Expression button. The Calculation Expression window will appear.
2. Select (highlight) the item to be used in the calculation. When the selected item has more than one period of data, you can also select a specific time period from the time period pull-down menu (above the Add Item button).

3. At the Function Parameters menu, click the <<Select>> button. The selected item's number and time period will appear in the Function parameters data boxes.

4. From the Function Category list, select the Custom Aggregates/Ranks category.

5. Next, select the desired function from the Function Name list. Specify Additional Parameters and then click the Add Selected Function button.

6. The Calculation Expression will appear in the Calculation Expression data entry box.

7. Enter the name for the calculated item in the entry box labeled “Calculation Expression (referred in the report as)”.

8. Click OK. The Screen by dialog box will appear. Specify the screening parameters and click OK. The Calculation Expression will be added to the Screening Criteria table.

Adding Calculation Expression to Reports: Custom Aggregates/Ranks

To add a calculated item using the Custom Aggregates/Ranks Functions, from the Report menu, select the Add Calculation Expression command or click the Add Calculation Expression button.

Available Custom Aggregates/Ranks Functions

- **AllAgg – All Aggregates.** Allows to select a certain aggregate for the full universe. To use, select from Average, Median, Sum, Hi, Low, number of observations, or Standard Deviation options from the Aggregate Type pull-down menu.

- **AllWtAv – All Weighted Average.** Calculates a Weighted Average for all companies in the database universe. To use, select (highlight) the Weight Item from the Items section of the Calculation Expression window, and click the <<Select>> button.

- **GrAgg – Group Aggregate.** Calculates a Group–specific aggregate. To use, select from Average, Median, Sum, Hi, Low, number of observations, or Standard Deviation options from the Aggregate Type pull-down menu. Next, select (highlight) the Group Item from the Items section of the Calculation Expression window, and click the <<Select>> button.

- **SpGrAgg – Special Group Aggregate.** Calculates special aggregates for Group. To use, select from Average, Median, Sum, Hi, Low, number of observations, or Standard Deviation options from the Aggregate Type pull-down menu. Next, select (highlight) the Group Item from the Items section of the Calculation Expression window, and click the <<Select>> button. Finally, specify if you want the selected aggregate to be True of False, by selecting one from the Boolean value pull-down menu.

- **GrOrdRank – Ordinal Rank in Group.** Calculate Ordinal Rank in Group. To use, select (highlight) the Group Item from the Items section of the
Calculation Expression window, and click the `<Select` button. Specify the Rank order.

- **GrUnRank – Uniform Rank in Group.** Calculate Uniform Rank in Group. To use, select (highlight) the Group Item from the Items section of the Calculation Expression window, and click the `<Select` button. Specify the Rank order and number of fractiles to be used in ranking.

- **GrHstRank – Histogram in Group.** Calculate Histogram Rank in Group. To use, select (highlight) the Group Item from the Items section of the Calculation Expression window, and click the `<Select` button. Specify the Rank order and number of fractiles to be used in ranking.
Backtesting

Overview

With the Research Wizard you can produce reports showing the performance of your screens (based on DBCM data items only). The Backtest option in the Research Wizard enables you to select a saved screen definition (DBCM items only) and to test it historically and view the screen's performance relative to a benchmark over time.

Running Backtest

To run a Backtest, follow these steps:

1. From the Research Wizard menu, select the Backtest option. The Backtest Screen Definition dialog box will appear.

2. At the Backtest Screen Definition dialog box, select a saved screen by clicking the Browse button and selecting a saved screen definition.

3. Select a time period using the From and To pull-down menus (dates are displayed at the week ends; Backtest ALWAYS shows one week BEFORE the last completed week as the first period for backtesting).

4. Select a Holding Period (in weeks).

5. Select the benchmark: S&P 500 or an Equal Weighted index (DBCM Universe; Eq Wt Index Return = Mean(PriceChg) + Mean(DivYeald) *(nWk/52)).

6. Click the Run button to view the results.

If the time frame specified in your backtest is outside the holding period span, you will see the results only for the completed holding periods. For example, if on July 6, 1999, you specified a 24-week holding period (with the time period set from 7/11/1997 to 6/25/1999), you will see 5 period returns, with the period five dated 5/14/1999 - the last complete 24-week period up to the current date.
**DBCM Items Not Suitable for Backtesting (Error 1001)**

There are some DBCM items that are not suitable for backtesting. If these items are included in the screen definition, the Research Wizard will produce an Error message 1001 - Backtest Failed, followed by the Query Error message.

The Research Wizard does not allow to backtest screens that include the following DBCM items:

- Est. One Year EPS Growth $F(1)/F(0)$ – item 529
- Est. Two Year EPS Growth $F(2)/F(0)$ – item 531
- 12 Mo. Forward Estimate/12 Mo. Actual – item 645
- Est.YTD EPS Gr.Q(1)/YTD Year ago – item 636
- Est.YTD EPS Gr.Q(2)/YTD Year ago – item 637
- Est.YTD EPS Gr.Q(3)/YTD Year ago – item 638
- Est.YTD EPS Gr.Q(4)/YTD Year ago – item 639
- Est.12 mo. EPS Gr.Q(1)/Year ago – item 533
- Est.12 mo. EPS Gr.Q(2)/Year ago – item 534
- Est.12 mo. EPS Gr.Q(3)/Year ago – item 535
- Est.12 mo. EPS Gr.Q(4)/Year ago – item 536
- Est. EPS Gr. Q(1)/Q(0) – item 547
- Est. EPS Gr. Q(2)/Q(1) – item 548
- Est. EPS Gr. Q(3)/Q(2) – item 549
- Est. EPS Gr. Q(4)/Q(3) – item 550
- Est. EPS Gr. Q(1)/Q(-3) – item 537
- Est. EPS Gr. Q(2)/Q(-2) – item 538
- Est. EPS Gr. Q(3)/Q(-1) – item 539
- Est. EPS Gr. Q(4)/Q(0) – item 540

**Screening Criteria Not Suitable for Backtesting (Error 1004)**

Screen Definitions that contain expressions “EVERY” or “ANY” cannot be backtested. If the screen contains any of these expressions, the Research Wizard will produce an Error message 1004, Bactest Failed, followed by the Query Error message.

**Data Limitations and Biases**

- The are two years of data available for the backtest.
- The backtest calculates the Total Return as % Price Change + Yield * (52 / Holding Period) in weeks. Since we are using 1, 4, 12, or 24 week holding periods, the above Total Return is only an approximation, but we think it is very close to the actual total return.
- The database used for Backtest has not been adjusted for splits. However, the backtest results are calculated using the Percent Change in Price item that is split adjusted.
The database used for Backtest contains only survivor companies, it is created using the DBCM universe, so all backtests using it have survivor bias.

On the plus side, the database used for Backtest is the only estimate database in existence that does not have a look ahead bias. For example, in other databases, the Current Fiscal Year (F1) estimates on a specific date \( t \) include estimates that were received on dates \( t+1 \), \( t+2 \), etc., that were dated before \( t \) by the broker but which had not yet been received on date \( t \). The (F1) estimates in the backtest database are what was known on date \( t \).

**Understanding Backtest Output Report**

The *Historical Performance of the Screen* report shows a summary of the strategy and compares it with the specified benchmark. It shows statistics such as portfolio return, benchmark return and excess returns for entire time span and for individual periods. It also displays how the investment strategy performed in up and down markets.

The *Historical Performance of the Screen* report contains the following data:

<table>
<thead>
<tr>
<th>Historical Performance of Screen LG, GFI from 04/11/1997 to 11/28/1998 12 week holding periods</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Period</strong></td>
</tr>
<tr>
<td>---</td>
</tr>
<tr>
<td>1</td>
</tr>
<tr>
<td>2</td>
</tr>
<tr>
<td>3</td>
</tr>
<tr>
<td>4</td>
</tr>
<tr>
<td>5</td>
</tr>
<tr>
<td>6</td>
</tr>
<tr>
<td>7</td>
</tr>
<tr>
<td>8</td>
</tr>
</tbody>
</table>

**Bactest Report.**

**Period** – displays the number of holding periods in your backtest. This number will depend on the time span and the number of weeks in your holding period specifications.

**Date** – identifies holding period end dates.

**Companies In Portfolio** – number of companies passed the screen in each period.

**Total Return of Portfolio %** – the return of the portfolio comprised of stocks that passed the screening criteria for the period. The returns are “forward - looking” - that is the return value for the week 6/11/1999 represents the return that would be earned during the week from 6/11/1999 to 6/18/1999. These returns are unweighted - in other words, the return for the portfolio is the arithmetic mean of the returns for individual companies in the portfolio.
Calculation: Total Return of Portfolio\%: \( \text{TotRet} = \text{PrChMean} + \text{DivYldMean} \times \frac{n\text{WeekBt}}{52} \); where PrChMean = Average of i120 (1 wk) or i11(4 wk) or i13(12 wk) or i15(24 wk) for active universe (DBCMHIST), and DivYldMean = Average i26 for active universe.

**Benchmark Total Return \%** – the return of the benchmark for the period shown.

**Excess Return of Screen \%** – the return of the portfolio less the return for the benchmark return for the period shown.

**Average** – average value of each of the columns.

**Up Markets** – average for those rank dates where the benchmark return was positive. Displays number of periods.

**Down Markets** – average for those rank dates where the benchmark return was negative. Displays number of periods.

**Annualized Return** – calculated as the average return raised to the power \((52 \text{ / Holding Period in Weeks})\).

Calculation: \( ((1 + \text{Average of TotRet}/100)^{52/n\text{WeekBt}} - 1) \times 100 \).
Graphics

Overview

With the Research Wizard Graphics option, you can produce several special charts: Hot Maps and X-Y Scatter Plot.

With the Hot Map charts, you can graphically evaluate the attractiveness of the companies within the active universe based on the items in your screen or report definitions.

Based on the numerical values of each report item, the companies are ranked on each item using the Full Universe Uniform Rank function (they are ranked into 100 fractiles, equal number of companies in each fractile). The individual scores are then combined into the Composite Rank (the Composite Rank of the company is equally weighted average of individual ranks per each item).

The final score is then interpreted using a color scheme: the most attractive companies are colored in green, and the least attractive are colored in red. The neutral is represented by white.

The X-Y Scatter Plots option produces a scatter plot of two database items. A scatter plot is useful in determining the relationship between two numerical variables. It is constructed simply by plotting the response Y variable (vertical axis) against the explanatory X variable (horizontal axis).

Hot Maps

Specifying Hot Maps

The Hot Map option allows you to graphically view the attractiveness of the companies within the active universe. The Hot Maps can be run only after displaying the results of a screen or a report. The Hot Maps are not available for all data items.

To use the Hot Map feature (after displaying the results of a screen or report), follow these steps:

1. From the Graphics menu, select the Hot Maps command. The Hot Maps chart will appear.

2. Use the Back button to return to the main menu.
Modifying Hot Maps Display

The Hot Maps display can be organized to view the results as organized by Sector or Industry.

To modify the Hot Map display, follow these steps:

1. At the Research Wizard main menu, click the Sort/Organize button. The Organize/Sort window will be displayed.
2. At the Organize by section, select the desired organizational option, and click OK.
3. Click the Run Query button.
4. From the Graphics menu, select the Hot Maps command. The modified Hot Maps chart will be displayed.

Hot Maps Organize Options

The following Organize options can be used:

- Zacks X (Expanded) Industry
- Zacks X (Expanded) Sector
- Zacks (M) Medium Aggregate Industry
- Organize by Zacks Expanded Sector and then by Expanded Industry designations
- Organize by Zacks Expanded Sector and then by Medium Aggregate Industry designations.

If you do not want to have your report organized, select None from the pull-down menu.

X-Y Scatter Plot

Specifying Scatter Plots

The X-Y Scatter Plot feature produces a scatter plot of the values of any pair of database items for the full or active universe. The graph also displays the results of a linear regression of the variables, including the estimated alpha and beta, the R-squared value, and the number of data points. In addition, the high and lows values for X and Y are provided.

To perform the analysis of two data items, follow these steps:

1. From the Graphics menu, select the X-Y Scatter Plot command. The X-Y Scatter Plot dialog box will be displayed.
2. You can chart the Scatter Plot for companies in either the Full or Active Universe. To specify the desired Universe option, select the corresponding radio button: Full or Active in the Universe selection section.
3. To select the X-axis item (the independent variable), click the **Browse** button located next to the **Axis X Item** box; to select the Y-axis item (dependent variable), click the **Browse** button located next to the **Axis Y Item** box. The list of the available database items will appear.

4. Double-click the item to select it and click **OK**.

5. After specifying the axes, click **Plot**. The X-Y Scatter Plot will be displayed.

6. To exit the X-Y Scatter Plot menu, click **Close**.

**Output Ticker List Option**

You can save the list of companies used in the X-Y Scatter Plot, by following these steps:

1. Click the browse button next to the Output Ticker List box.
2. At the Output Ticker List menu, specify the Ticker List name and location. You can either type a new Ticker List name, or select an existing Ticker List (if you specify the existing Ticker List, its contents will be replaced with the companies used in the X-Y Scatter Plot). Click Open when done.

3. To add the companies used in the X-Y Scatter Plot to the specified Output Ticker List, click the Add All button.

4. Click View to see the companies on the list.

**X-Y Scatter Plot Display and Summary**

A regression line is fit to a Scatter Plot. Next to the graph, the X-Y Scatter Plot summary is displayed. The summary section displays regression statistics: estimated alpha, estimated beta, R-squared, the size of the active universe, number of cases (non-N/A values), and Low and High for the X and Y values.

**Manipulating X-Y Scatter Plot Display**

You can zoom in to the specific parts of the chart, exclude some tickers from the plot, or add some companies to the Output Ticker List. To perform any of these tasks, follow these steps:

1. At the X-Y Scatter Plot display, place your cursor at the area you want to analyze.

2. Click the left mouse button, hold it down and drag it up or down to form a rectangular outline.

3. You will have the following options available at the drop-down menu: Zoom In, Exclude and Add to Ticker List. Select the desired option from the menu.

4. To return to the original display, click the Reset button.
**Zoom-In Option**

After selecting the area to view, use the Zoom In option to analyze the selected companies.

**Exclude Option**

After selecting the area to view, use the Exclude option, to eliminate specific companies from the chart (useful for removing extreme data values).

**Add to Ticker List Option**

After selecting the area of the chart, you can add companies bounded by the area to the specified Output Ticker List.

**Detailed Data Window**

To view companies associated with a stand alone data point, double-click that data point on the Scatter Plot.

A *Detailed Data* window will be displayed, showing the X and Y values for the companies associated with the data point.

![Detailed Data Window](image)

Click OK to close the window.

**Printing X-Y Scatter Plot**

Click the Print button at the X-Y Scatter Plot menu to print the graph.
Working with Scripts

Introduction

When you have defined your screens and reports, you can then combine these tasks in one-step process using the Script feature of Research Wizard. Once you have defined your script, with one click you can then run a series of screens and reports, an then print or export the results.

The script files have extension (*.scr), and are usually stored in the Inputs folder of Research Wizard.

Scripting Process Overview

To create a script you will need to select a task from the Operation list, specify the Parameters for the operation, and then add that task to the script.

Available Script Operations

The following is a list of Script Operations:

- **Open Saved Screen Definition** – select a screen to be used in the script.
- **Open Ticker List** - select a Ticker List to be used in your script.
- **Open Saved Report Definition** - select a report definition to be used in the script.
- **Run Screen/Report Query** - select options for the reports’ output.
- **Print Snapshot for Active Tickes** – print Snapshot reports for all companies that passed particular screen.

Available Script Parameters

An Operation selection you made (at the Research Wizard Script dialog box) will determine the Parameters choices in script. You can specify the location of your screens, portfolios, and reports; select the Full Universe, Active Universe or Ticker List to be used in screening; select the desired output (save in a specific file format, export to other applications, or print).

<table>
<thead>
<tr>
<th>Operation</th>
<th>Script Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open Saved Screen Definition</td>
<td>At the Parameters menu, click the <strong>Browse</strong> button to locate the Saved Screen Definition file. If you want to run a subsequent screen on companies that passed your first screening criteria, mark the <strong>Active Universe Only</strong> check box to limit your universe to those that passed the screen.</td>
</tr>
<tr>
<td>Open Ticker List</td>
<td>At the Parameters menu, click the <strong>Browse</strong> button to locate the Ticker List for the report.</td>
</tr>
</tbody>
</table>
### Operation Script Parameters

<table>
<thead>
<tr>
<th>Operation</th>
<th>Script Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open Saved Report Definition</td>
<td>At the Parameters menu, click the <strong>Browse</strong> button to locate the Report Definition file.</td>
</tr>
</tbody>
</table>
| Run Screen/Report Query           | This is a special set of parameters that will allow you to specify the desired output for your screens and reports by using the Parameters pull-down menu. You MUST include the Run Screen/Report Query operation line in your script to produce the output.  
At the Parameters menu, select from the following:  
- **Print** - will print the selected report  
- **Save as Text (tab-delimited)** - will save the report results in a *.txt file (specify the file name and location)  
- **Save as Formatted Text (space-delimited)** - will save the report results in a *.prn file (specify the file name and location)  
- **Save as CSV (comma-delimited)** – will save the report results in a *.csv file (specify the file name and location)  
- **Save as Ticker List** check box – mark it to save the companies that passed the screening criteria in a Ticker List (specify the file name and location) |
| Snapshot Batch Print              | No additional parameters.                                                                                                                          |

### Creating New Scripts

To create a new script, follow these steps:

1. From the **Script** menu select the New Script command. The *Research Wizard Script* dialog box will be displayed.
2. Highlight the desired action from the **Operation** menu and then select the corresponding script **Parameters**.

3. After selecting each parameter, click the **Add** button. The specified action will appear in the **Script** section of the *Research Wizard Script* window.

4. Click **Save** when done.

**Running Scripts**
To run a previously saved script, follow these steps:
1. From the **Script** menu, select the Run Script command.
2. At the *Research Wizard Script* dialog box, select the script file and click **Open**.

**Editing Scripts**
To edit a previously saved script, follow these steps:
1. From the **Script** menu, select the Edit Script command.
2. At the *Research Wizard Script* dialog box, select the script file and click **Open**.
3. At the **Script** window, make the desired changes to the script. To remove a line from the Script section, highlight it and click the **Remove** button.
4. Save your script.
Screening Examples

Basic Screening

The following examples will introduce you to the screening basics. Before running each screen, clear both the Screening Criteria and Report Definition tables, unless otherwise noted.

Screening for Investable Universe

Using the Current Market database (DBCM) of over 6,500 companies, let’s narrow down our investable universe to include companies with the market cap over 500 million and that are followed by at least 3 analysts.

Define a screen for stocks with a market capitalization above 500 million:

1. From the list of Categories, choose a Company category and then the sub-category - Size and Share Volume.
2. From the Items section, choose the Company Size category and highlight the Market Value ($mil) item.
3. Double-click the Market Value ($mil) item (or select the Screen by Database Item command from the Screen menu) or click the Screen by Database Item button.
4. The Screen By dialog box will be displayed. From the operators pull-down menu, select the greater than (>) operator.
5. In the value entry box type the market capitalization: “500 “ (market cap item is in millions) and click OK.

6. The screening item will appear in the Screening Criteria table (below the Categories and Items section). It will also be added to the Report Definition table.

Next, screen for the companies followed by at least 3 analysts:

7. From the list of Categories, select the EPS category and then the Fiscal Year Estimates sub-category.
8. From the Item list, choose the Estimates for Current Fiscal Year category and highlight the F(1) # Analysts in Consensus item.
9. Double-click the F(1) # Analysts in Consensus item (or select the Screen by Database Item command from the Screen menu) or click the Screen by Database Item button.
10. The Screen By dialog box will appear. From the operators pull-down menu, select the equal or greater than (>=) operator.
11. In the value entry box type “3” and click OK.

![Screen By dialog box]

12. The screening item will appear in the Screening Criteria table (below the Categories and Items section). It will also be added to the Report Definition table.

13. Next, click the Run Query button to run the investable universe definition screen.

When you have executed the screen, your active universe will consist of only those tickers that meet all of your screening criteria and the Screening Criteria table will show the number of tickers passed the screen.

**Screening on Stocks vs. their Industry**

Continue from the previous example.

Now that we have defined our investable universe, let’s find companies that have an EPS growth that is above the median for their Industry and for which analysts are revising their estimates.

(If you are at the Report display, click the Back button to return to the main menu).

**Define a screen for stocks that have an EPS growth above their X Industry median:**

1. From the list of Categories, select the Growth category and then the EPS Projected sub-category.

2. From the Item list, choose the Trend category and highlight the Next 3-5 Years Est EPS Growth (%/yr) item.

3. Double-click the Next 3-5 Years Est EPS Growth (%/yr) item (or select the Screen by Database Item command from the Screen menu) or click the Screen by Database Item button.

4. The Screen By dialog box will appear. From the operators pull-down menu, select the greater than (>) operator. In the Compare to section, choose Group.

5. From the Group pull-down menu, select X Industry as the group and select Median as the aggregate. Leave the default “1.00” value in the coefficient box (the default coefficient of 1.00 represents the Industry median) and click OK.
6. The screening item will appear in the Screening Criteria table (below the Categories and Items section). It will also be added to the Report Definition table.

Next, search for companies with the estimate increases above 3%:

7. From the list of Categories, select the EPS category and then the Estimate Revisions sub-category.

8. From the Item list, choose the Estimate Revisions - Last 12 Weeks category and highlight the %Change F(1) Est. - 4 Weeks item.

9. Double-click the %Change F(1) Est. - 4 Weeks item (or select the Screen by Database Item command from the Screen menu) or click the Screen by Database Item button.

10. The Screen By dialog box will appear. From the operators pull-down menu, select the greater than (>) operator. In the value entry box type “3” and click OK.

11. The screening item will appear in the Screening Criteria table (below the Categories and Items section). It will also be added to the Report Definition table.

12. Next, click the Run Query button to run the screen and view the companies that meet our criteria.

Screening on Two Criteria

Screen for stocks that have a P/E (using F1 estimate) 20% below the X Industry median and are paying dividends.

1. From the list of Categories, select the Ratios category and then the P/E sub-category.

2. From the Item list, choose P/E Ratios using EPS Estimates category and highlight the P/E using F(1) Estimate item.

3. Double-click the P/E using F(1) Estimate item (or select the Screen by Database Item command from the Screen menu) or click the Screen by Database Item button.
4. The Screen By dialog box will be displayed. From the operators pull-down menu, select the less than (<) operator. In the Compare to section, choose Group.

5. From the Group pull-down menu, select X Industry as the group and select median as the aggregate.

6. Next, type 0.8 in the coefficient box. The default coefficient of 1.00 represents the Industry median. Typing 0.8 will indicates the P/E 20% below the median P/E. Click OK.

7. The screening item will appear in the Screening Criteria table (below the Categories and Items section). It will also be added to the Report Definition table.

Next you would like to include only stocks that pay dividends. To do this, screen for stocks with a current dividend yield above 0.

8. From the list of Categories, select the Ratios category and then the Dividend and Payout sub-category.

9. From the Item list, choose the Dividend Ratio category and then highlight the Current Dividend Yield (%) item.

10. Double-click the Current Dividend Yield (%) item (or select the Screen by Database Item command from the Screen menu) or click the Screen by Database Item button.

11. The Screen By dialog box will appear. From the operators pull-down menu, select the greater than (>) operator. In the value entry box type “0” and click OK.

12. The screening item will appear in the Screening Criteria table (below the Categories and Items section). It will also be added to the Report Definition table.

13. Next, click the Run Query button to run the screen and view the companies that meet our criteria.
Screening for Growth

ROE > 20%, Estimated EPS Growth > 20% and P/E 12 month < 15.

1. From the list of Categories, select the Ratios category and then the Return on Investments sub-category.

2. From the Item list, choose the Return on Equity (ROE) category and highlight the ROE - Most Recent 12 month (%) item.

3. Double-click the ROE - Most Recent 12 month (%) item (or select the Screen by Database Item command from the Screen menu) or click the Screen by Database Item button.

4. The Screen By dialog box will appear. From the operators pull-down menu, select the greater than (>) operator. In the value entry box type “20” and click OK.

5. The screening item will appear in the Screening Criteria table (below the Categories and Items section). It will also be added to the Report Definition table.

6. From the list of Categories, select the Growth category and then the EPS Projected sub-category.

7. From the Item list, choose the Trend category and highlight the Next 3-5 Years Est EPS Growth (%/yr) item.

8. Double-click the Next 3-5 Years Est EPS Growth (%/yr) item (or select the Screen by Database Item command from the Screen menu) or click the Screen by Database Item button.

9. The Screen By dialog box will appear. From the operators pull-down menu, select the greater than (>) operator. In the value entry box type “20” and click OK.

10. The screening item will appear in the Screening Criteria table (below the Categories and Items section). It will also be added to the Report Definition table.

11. From the list of Categories, select the Ratios category and then the P/E sub-category.

12. From the Item list, choose P/E Ratios using EPS Actuals category and highlight the P/E using 12 month EPS item.

13. Double-click the P/E using 12 month EPS item (or select the Screen by Database Item command from the Screen menu) or click the Screen by Database Item button.

14. The Screen By dialog box will appear. From the operators pull-down menu, select the less than (<) operator. In the value entry box, type “15” and click OK.

15. The screening item will appear in the Screening Criteria table (below the Categories and Items section). It will also be added to the Report Definition table.

16. Next, click the Run Query button to run the screen and view the companies that meet our criteria.

Screening for Value

Trailing 12 month P/E < 15, Price/Book < 1 and ROE > 15%.
1. From the list of Categories, select the Ratios category and then the P/E sub-category.

2. From the Item list, choose P/E Ratios using EPS Actuals category and highlight the P/E using 12 month EPS item.

3. Double-click the P/E using 12 month EPS item (or select the Screen by Database Item command from the Screen menu) or click the Screen by Database Item button.

4. The Screen By dialog box will appear. From the operators pull-down menu, select the less than (<) operator. In the value entry box, type “15” and click OK.

5. The screening item will appear in the Screening Criteria table (below the Categories and Items section). It will also be added to the Report Definition table.

6. From the list of Categories, select the Ratios category and then the Valuation sub-category.

7. From the Item list, choose the Price/Fundamentals category and highlight the Price/Book (Common Equity) item.

8. Double-click the Price/Book (Common Equity) item (or select the Screen by Database Item command from the Screen menu) or click the Screen by Database Item button.

9. The Screen By dialog box will appear. From the operators pull-down menu, select the less than (<) operator. In the value entry box, type “1” and click OK.

10. The screening item will appear in the Screening Criteria table (below the Categories and Items section). It will also be added to the Report Definition table.

11. From the list of Categories, select the Ratios category and then the Return on Investments sub-category.

12. From the Item list, choose the Return on Equity (ROE) category and highlight the ROE - Most Recent 12 month (%) item.

13. Double-click the ROE - Most Recent 12 month (%) item (or select the Screen by Database Item command from the Screen menu) or click the Screen by Database Item button.

14. The Screen By dialog box will appear. From the operators pull-down menu, select the greater than (>) operator. In the value entry box, type “15” and click OK.

15. The screening item will appear in the Screening Criteria table (below the Categories and Items section). It will also be added to the Report Definition table.

16. Next, click the Run Query button to run the screen and view the companies that meet our criteria.

Using Historical Search Option

The Historical Search option allows you to screen on several data periods. In addition, you can specify whether you want the specific conditions to be met in Every or Any period.

In this example you will screen for companies that had a positive pre-tax income Every year for the past three years. We will be using DBCM item 84.
1. From the Categories list select the Income Statement category.
2. From the Items list, select the Annual category and then highlight the Pretax Income ($mil) item.
3. Double-click the Pretax Income ($mil) item (or select the Screen by Database Item command from the Screen menu) or click the Screen by Database Item button.
4. The Screen By dialog box will appear. Check the Historical Search box.
5. Using the corresponding pull-down menus, select the desired time periods and the option Every year.
6. From the operators pull-down menu, choose the greater than (>) operator. In the value entry box, type "0" and click OK.

![Screen By dialog box](image)

7. The screening item will appear in the Screening Criteria table (below the Categories and Items section). It will also be added to the Report Definition table.

**Examples of Advanced Screening and Reporting**

**Calculating New Items Using Existing Database Items**

Suppose you want to include the Sales-to-Average Working Capital ratio in your report for a portfolio. You can create this item using the DBCM items 80 (Annual Sales), 88 (Annual Total Current Assets), and 89 (Annual Total Current Liabilities).

Working Capital is calculated as the difference between the current assets and current liabilities. To create an average Working Capital we will use the average Total Current Assets and the average Total Current Liabilities.

To create the Sales-to Average Working Capital ratio using the Direct Method (manually typing in the calculation expression), follow these steps:

1. Select a Ticker List first.
2. From the Report menu, select the Add Calculations Expression command or click the Add Calculations Expression button. The Calculation Expression window will be displayed.
3. Type the following formula in the Calculation Expression data entry box:
   
   \[ i80 / ((i88 + i88[-1]) - (i89 + i89[-1])) / 2 \]
4. Click OK.
5. The calculated item will be added to the **Report Definition** table.

To create the above calculation using your mouse, select the items and operators by double-clicking them from the corresponding sections of the Calculation Expression window.

---

**How to Screen for Several Industries**

This example will show how to screen for several X Industries at the same time using the DBCM database.

1. From the **Categories** section, select the **Company** category and then the Descriptive sub-category.
2. From the **Items** section, select the **Sector and Industry Codes** category and highlight the Zacks Industry Codes \(1-200+\) item.
3. Double-click the Zacks Industry Codes item. The **Screen by** dialog box will appear, containing the list of available X Industries.
4. Press **Ctrl** key on your keyboard and at the same time highlight Industry \(211\) (Electronic Commerce, \(212\) (Internet Content, \(213\) (Internet Services) and \(214\) (Internet Software) with your left mouse button.
5. Click OK.
6. The selected Industries will be added to the **Screening Criteria** table.

**Tip:** To screen for several consecutive industries, hold your **Shift** key and highlight consecutive industries with your mouse.

---

**Using Moving Functions in Reports**

In this example, we will create a report with the MovingHi calculation for the 12 month-end prices for the companies in your portfolio (using the DBCM database).

To use the MovingHi function, follow these steps:

1. After selecting the portfolio, from the **Report** menu, select the Add Calculation Expression command or click the **Add Calculation Expression** button. The Calculation Expression window will appear.
2. From the list of categories, select the **Price and Price Changes** category.
3. From the **Items** list, select the **Price** category and highlight the Month-end Price item \(i6\).
4. From the Function Category menu, select the Moving Average option.
5. From the Function Name menu, highlight the MovingHi function and double-click it to open up the **Moving Average** dialog box.
6. In the **Moving Average** dialog box, enter 12 as the number of periods and Click OK.
7. The following expression will appear in the Calculation Expression data entry box: MovingHi12\((i6)\).
8. Click OK.
Using Boolean "And" Calculations

Example A

“Technical Investor”: Screen the DBCM database for companies with significant recent price action. Select those companies with a 20% price increase over the last 4 week period and a 50% price increase over the last 12 week period.

Four week %Price change is DBCM Item 11 and twelve week %Price Change is DBCM Item 13.

1. From the Screen menu, select the Screen by Calculation Expression command or click the Screen by Calculation Expression button. The Calculation Expression window will be displayed.

2. Type the following expression into the Calculation Expression data entry box:

   i11>20 And i13>50

3. Click OK.

4. The Screen By dialog box will appear. Select TRUE from the menu options to include only those companies that meet both conditions (20% price increase over the last 4 week period and a 50% price increase over the last 12 week period).

5. The Screening Criteria table will fill up showing the calculation. The Report Definition will also contain the calculation expression. You may want to delete it from the Report Definition, because every company will have 1 as the data value. Instead, you may want to include a 4 week % Price Change item and a 12 week %Price Change item.

6. Click the Run Query button to view the companies that passed your screen.

Example B

Search for companies with the P/E in a 15 to 25 range and include only companies with the positive EPS.

We will use DBCM items 34 (12 month Trailing EPS) and 76 (P/E using 12 month EPS). We will use the Choose and Click Method for creating this calculation expression.

Here is how you can define these conditions:

1. From the Screen menu, select the Screen by Calculation Expression command or click the Screen by Calculation Expression button. The Calculation Expression window will be displayed.

2. From the list of categories, select the Ratios category and then the P/E sub-category.

3. From the Items list, select the P/E ratios using EPS Actuals category and highlight the P/E using 12 month EPS item. Double-click the item; it will be added to the Calculation Expression data entry box: i76.

4. From the Operator Category, select Comparison and highlight the greater than (>) operator and click the Add Operator button.

5. In the Calculation Expression data entry box, type "15" (i76 > 15).
6. From the Operator Category, select Logical and highlight the "And" operator and click the **Add Operator** button.

7. From the list of categories, select the **Ratios** category and then the P/E sub-category.

8. From the **Items** list, select the **P/E ratios using EPS Actuals** category and highlight the P/E using 12 month EPS item. Double-click the item, it will be added to the Calculation Expression data entry box: i76.

9. From the Operator Category, select Comparison and highlight the less than (<) operator and click the **Add Operator** button.

10. In the Calculation Expression data entry box, type "25" (i76 < 25).

11. From the Operator Category, select Logical and highlight the "And" operator and click the **Add Operator** button.

12. From the **Categories** list, select EPS, and then Actual sub-category.

13. From the **Items** list, select the 12 Month trailing and highlight the 12 month EPS before NRI item. Double-click that item to be added to the Calculation Expression data entry box (i34).

14. From the Operator Category, select Comparison and highlight the greater than (>) operator and click the **Add Operator** button.

15. In the Calculation Expression data entry box, type "0" (i34 > 0), so that final calculation expression will look like this:

   \[ i76 > 15 \text{ And } i76 < 25 \text{ And } i34 > 0 \]

16. Click **OK**.

17. The **Screen By** dialog box will appear. Select TRUE from the menu options to include only those companies meeting all three conditions (P/E ratios in a 15 to 25 range and only positive EPS).

18. The **Screening Criteria** table will fill up showing the calculation. The Report Definition will also contain the calculation. You may want to delete it from the Report Definition, because every company will have 1 as the data value. Instead, you may want to include the items 76 and 34.

19. Click the **Run Query** button to run the screen.

### Using Boolean "Or" Calculations

In this example, we will search for companies that have P/E in a 20 to 25 range or PEG Ratio of 1. We will use DBCM items 72 - P/E using F(1) Estimate and item 551 - PEG Ratio (P/E F(1)/ EPS Growth). We will use the Direct Method for creating this calculation expression.

**Here is how you can define these conditions:**

1. From the **Screen** menu, select the Screen by Calculation Expression command or click the **Screen by Calculation Expression** button. The **Calculation Expression** window will appear.

2. In the Calculation Expression data entry box, type the following formula:

   \[ i72 > 20 \text{ And } i72 < 25 \text{ Or } i551 = 1 \]

3. Click **OK**. The **Screen By** dialog box will appear. Select TRUE from the menu options.

4. The **Screening Criteria** table will fill up showing the calculation. The Report Definition will also contain the calculation. You may want to
delete it from the Report Definition, because every company will have 1 as the data value. Instead, you may want to include the items 72 and 551.

**Sample Script**

Here is a sample script that selects a screening definition, runs a report, saves the report as a *.csv file and saves the companies that passed the screen as a Ticker List.

![Sample Script](image)

**Screening/Reporting on Multiple Databases**

To create a calculation involving data from multiple databases, use the following syntax at the Calculation Expression menu:

1. If you want to use the item from the active database and another database, you can specify the following calculation: `i5/DBDA:i25`

2. If you have one active database and want to use the items from two other databases, you can specify the following calculation:

   `DBCM:i6/DBDP:i6`

**Using Index Tickers**

Zacks databases contain information on various Indexes. The following table lists the available Indexes and corresponding ticker symbols:

<table>
<thead>
<tr>
<th>Index</th>
<th>Ticker</th>
</tr>
</thead>
</table>

---

Research Wizard 4.0  
Screening Examples  •  83
<table>
<thead>
<tr>
<th>Index Name</th>
<th>Symbol</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dow Jones Industrial Average</td>
<td>INDU</td>
</tr>
<tr>
<td>Nasdaq Composite</td>
<td>COMPX</td>
</tr>
<tr>
<td>Russell 2000</td>
<td>RUT.X</td>
</tr>
<tr>
<td>S&amp;P 100</td>
<td>OEX.X</td>
</tr>
<tr>
<td>S&amp;P 500</td>
<td>SPAL</td>
</tr>
<tr>
<td>S&amp;P 500 As Reported</td>
<td>SPX.X</td>
</tr>
<tr>
<td>S&amp;P Industrial</td>
<td>SPIN</td>
</tr>
<tr>
<td>S&amp;P Industrial As Reported</td>
<td>SPN.X</td>
</tr>
<tr>
<td>S&amp;P MidCap 400</td>
<td>MID.X</td>
</tr>
<tr>
<td>S&amp;P SmallCap 600</td>
<td>SML.X</td>
</tr>
<tr>
<td>Wilshire 5000</td>
<td>WLSH</td>
</tr>
</tbody>
</table>
How to Use EZ Screen

Click the **EZ Screen** button from the Research Wizard display to access the **EZ Screen** menu.

The EZ Screen has thirteen pre-selected Items and six pre-defined Criteria. You assign a **Priority** rank. A **Priority** rank (1-13) determines the order in which the software will run the screen. The default priority is from top-to-bottom.

You may want to include only few items for your screening by selecting values from the six criteria options. If you want to include an item in your screen, select a criterion and its value from the **Criteria** pull-down menu. If you do not want an item to be in your screen, leave its **Criteria** option box as **Not Applicable**.

After making your selections, click the **Run** button to perform the screen and generate a report. The EZ Screen reports will include all thirteen items shown in the menu.

**EZ Screen Functionality Overview**

The EZ Screen allows you to screen and generate reports using thirteen pre-designated items based on six pre-determined criteria. This gives you a simplified point-and-click screening/reporting access to the DBCM database.
EZ Screen: 13 Screening Items

The screening items in the EZ Screen are as follows:

- **Market Value** – Market Capitalization in millions: (Current Price x Shares Outstanding).

- **Zacks Rank** – based on Zacks Indicator score. The Zacks Indicator is a proprietary fundamental stock selection model, which predicts stock price movements based on estimate revisions and EPS surprises. 1 = Strong Buy; 2 = Buy; 3 = Hold; 4 = Sell; 5 = Strong Sell; N/A = Not available.

- **% Price Change - 1 Week** – Percentage price change for one week.

- **% Price Change - 4 Week** – Percentage price change for four weeks.

- **% Price Change - YTD** – Percentage price change for the year to date period.

- **Average Broker Rating** – The average of analyst ratings for company (Strong Buy = 1; Buy = 2; Hold = 3; Sell = 4; Strong Sell = 5).

- **Last EPS Surprise** – Calculated as [(Act EPS Q - Last Est Q0)/Absolute value of Last Est Q0] x 100.

- **Estimate Revisions - % Change F(1) 4 Week** – Percent change in mean EPS estimate for the current fiscal year over the last four weeks. Calculated as: ((Est EPS F1 [current]-Est EPS F1 [4 weeks ago])/Absolute value of Est EPS F1 [4 weeks ago]) x 100.

- **Growth - EPS Projected - Next Year** = (F1)/(F0) – Estimated EPS growth for one year using consensus estimate of current fiscal year divided by EPS of last completed fiscal year (actual if reported - consensus if not). EPS is before NRI.

- **Growth - EPS Projected - Next 3-5 Yrs (%/yr.)** – Mean estimate for long-term (3-5 year) annualized EPS growth as of the last completed week.

- **PEG Ratio** – PEG Ratio: P/E to expected EPS growth using next fiscal year estimates and projected earnings growth. A PEG of 1.0 means that a stock is trading in line with its projected growth rate.

- **P/E using F(1) estimate** – Price/Earnings ratio using current fiscal year estimated earnings and current price.

- **Current Yield (%)** – Current dividend yield.

EZ Screen: 6 Screening Criteria

The pre-determined criteria are as follows:

- **Top 10 % of the Full Universe** – 10 percent of the total number of companies.

- **Top 25 % of the Full Universe** – 25 percent of the total number of companies.

- **Top 50 % of the Full Universe** – 50 percent of the total number of companies.

- **Bottom 50 % of the Full Universe** – 50 percent of the total number of companies.
- **Bottom 25% of the Full Universe** – 25 percent of the total number of companies.
- **Bottom 10% of the Full Universe** – 10 percent of the total number of companies.

The terms “Top” and “Bottom” mean best or worst performers.

**Screening Priority**

The EZ Screen runs the top-most criteria first and then proceeds down the list. Priority allows you to specify the order in which your screen is run.

Simply assign a 1-13 value to the criteria in the order that you want the screen to be run. This enables you to decide which criteria is screened first and so on.

Because the EZ Screen runs screens on a percentage basis, it is possible that when you change the priority, you will have a different set of tickers.

**EZ Screen Screening and Reporting**

To set up an EZ Screen, select your screening items from the set and pick the value for each criterion. You may want to include only few items for your screening by selecting values from the six criteria options. If you want to include an item in your screen, select a criterion and its value from the Criterion pull-down menu. If you do not want an item to be in your screen, leave its Criteria option box at Not Applicable.

Next, assign a Priority Rank. A priority rank (1-13) determines the order in which the software will run the screen. The default priority is from top-to-bottom.

After making your selections, click the Run button to perform the screen and generate a report. The EZ Screen reports will include all thirteen items shown on the menu.

**Saving EZ Screen Definitions**

To save the EZ Screen definition, follow these steps:

1. After defining a screen, click Save from the EZ Screen menu.
2. The EZ Screen Definition dialog box will appear. In the File Name box, type a name for the saved screen and then click Save.
3. The file will be saved with the *.ezd extension.

**Running Saved EZ Screen Definitions**

To run a saved EZ Screen definition, follow these steps:

1. Click the EZ Screen button from the Research Wizard menu to display the EZ Screen window.
2. At the EZ Screen window, click Open.
3. At the EZ Screen Definition dialog box, select the saved definition (file with the *.ezd extension) and click Open.
4. Click Run.
Alerts

Alert Reports Overview

The Alert Reports provide you with the ability to monitor significant events that can impact the future prices of stocks in your portfolio. The events monitored by Alert Reports include: changes in consensus EPS estimates, changes in individual analyst EPS estimates, changes in consensus recommendations, changes in individual analyst recommendations, EPS surprises, price changes and notifications of the dates companies are expected to announce their earnings.

Academic and investment industry research confirms that stock prices move before, during, and after such events. Stock prices may respond as long as 90 days after these events. Alert Reports give you time to take action for a positive result.

Using Alert Reports

To run a report, follow these steps:

1. Select the Alerts button from the Research Wizard menu to access the Alert Reports menu.
2. Next, select a report from the report categories.
3. Specify if you want this report for a portfolio or a universe. Select any additional parameters, when applicable.
4. Click the Run Report button to display the report.
Specifying Alerts Parameters

Before running a report, you need to specify the parameters (set of companies) for your report: specific portfolio or full universe. Some of the reports will also include additional options.

**Alert Parameters: Selecting Portfolio**

Alert Reports’ default portfolio is Myportf.txt. You can select a new portfolio by following these steps:

1. From the *Alert Parameters* section, click the *Portfolio* radio button.
2. At the *Portfolio* selection section, click the *Browse* button.
3. The *Open Portfolio* dialog box will appear. In the *Look in* box, click the drive and folder that contains the file.
4. In the folder list, double-click folders until you open the folder that contains the file you want.
5. Double-click the portfolio file you want to open or click *Open*.

To specify a new default portfolio, follow these steps:

1. From the *Tools* menu, click *Options*. The *Options* dialog box will appear.
2. Click *Portfolio* tab. The current Default Portfolio will be shown.
3. At the *Default Portfolio* section, click *Browse*.
4. The Default Portfolio dialog box will appear. In the *Look in* box, click the drive and folder that contains the file.
5. In the folder list, double-click folders until you open the folder that contains the file you want.
6. Double-click the portfolio file you want to open or click *Open*.
7. Click *OK*.

If you want to view Top/Bottom companies in your portfolio (based on the specific report criteria), mark the *Screening* check box and select Top/Bottom number.
Alert Parameters: Full Universe

Some reports give you an option to select Top/Bottom companies from the Zacks database of over 6,500 stocks. To use this option, click the Full Universe radio button at the Alert Parameters section. When using the Full Universe option you will be provided with the choice to include either “Top” (best) performers or “Bottom” (worst) performers according to the criteria of the chosen report.

In addition, you can specify the number of companies to be included in the report (default is 50).

To change the Full Universe default parameters, follow these steps:

1. From the Tools menu, click Options.
2. Click the Alert Parameters tab.
3. Type a new number at the Top/Bottom selection box.
4. Click OK.

Saving Tickers As Portfolio

After running an Alert Reports on Full Universe, you may want to save the companies that the report produces as a portfolio. To do so,

1. From the Data menu, click Save Tickers As List.
2. At the Ticker List dialog box, specify the name and location of the portfolio.
3. Click Save.

Companies displayed in a report defined using the Full Universe option are selected from the database using Zacks pre-set ranking criteria and cannot be changed by the user.

Additional Alert Parameters

Certain reports provide you with additional choices for displaying company information. For example:

- Change in Average Recommendations report – you can select to show changes for the last week or last 4 weeks.
- Change in Analyst Recommendations – specify past N-days.
- Recent Consensus EPS Revisions – choose revisions during the last 1, 4, or 12 weeks for the current fiscal year (F1); last 4, 12 weeks for the next fiscal year (F2); last 4 weeks for the completed fiscal quarter (Q0); last 4 weeks for the current fiscal quarter (Q1); or last 4 weeks for next fiscal quarter (Q2).
- Recent Analyst EPS Revisions – choose revisions for the completed fiscal year (F0), current fiscal year (F1), next fiscal year (F2), completed fiscal quarter (Q0), current fiscal quarter (Q1), or next fiscal quarter (Q2) for the last N-days.
- Reported EPS Surprises – specify last N-days.
- Expected Report Date – specify next N-days.
- Predicting Next Surprise - Most Accurate Analysts – specify next N-days.
Predicting Next Surprise - Most Recent Analysts – specify next N-days.

Most Accurate Consensus – specify completed fiscal year (F0), current fiscal year (F1), next fiscal year (F2), completed fiscal quarter (Q0), current fiscal quarter (Q1), or next fiscal quarter (Q2).

Most Recent Consensus – specify completed fiscal year (F0), current fiscal year (F1), next fiscal year (F2), completed fiscal quarter (Q0), current fiscal quarter (Q1), or next fiscal quarter (Q2).

Price Change – choose for the last: week, 4 weeks, 12 weeks, 24 weeks, or Year-to-Date (YTD).

Changing Additional Alerts Parameters

You can set a new defaults for the additional Alert Parameters, such as Fiscal Period, Last Days, Next Days, and Top/Bottom number. To change Alert Parameters, follow these steps:

1. From the Tools menu, click Options.
2. The Options dialog box will appear. Click the Alert Parameters tab and enter new parameters.
3. Click OK.

Alert Report Categories

Broker Recommendations Category

Average Recommendations

This report displays an average recommendation for each stock in your portfolio or universe. To compute the average recommendation Zacks uses a scale of 1 to 5, where 1 represents a "Strong Buy" and 5 represents a "Strong Sell".

In addition to the average recommendation, this report shows the number of "Strong Buy", "Buy", "Hold", "Sell", and "Strong Sell" recommendations for each stock.

Average Recommendations vs. Industry

This report compares the average broker recommendations (rating) for each company in the portfolio with the average broker recommendations (rating)
for the corresponding Zacks Medium Industry. The report also shows the difference in these ratings.

To compute the average recommendation Zacks uses a scale of 1 to 5, where 1 represents a “Strong Buy” and 5 represents a “Strong Sell”.

**Change in Average Recommendations**

This report shows the percent change in the average broker recommendation for a specified time period (one or four weeks) for each stock in your portfolio or universe. Also included are new and old recommendations.

To compute the average recommendation Zacks uses a scale of 1 to 5, where 1 represents a “Strong Buy” and 5 represents a “Strong Sell”.

The positive percent change indicates an improvement in the average ratings, for example a change from 1.73 to 1.63 is a positive 6.25%. The negative percent change indicates a worsening in the average ratings, for example, a change from 2.93 to 3.07 is a negative 4.72%.

**Change in Analyst Recommendations**

This report shows the changes in the individual analyst ratings for the stocks in your portfolio. You can specify the time period for the ratings changes. The default is set to the last 30 days.

If during the specified time period there were no changes in the analyst recommendations for any stock in your portfolio, that particular stock will not appear in the report.

The Change in Analyst Recommendations report includes:

- **Rating**
  - SB - Strong Buy, for ratings = 1.0
  - B - Buy, for ratings between 1.1 and 2.0
  - H - Hold, for ratings between 2.1 and 3.0
  - S - Sell, for ratings between 3.1 and 4.0
  - SS - Strong Sell, for ratings between 4.1 and 5.0
  - NR - No Rating

- **Rating Change** - describes the direction and magnitude of a change in the analyst’s ratings:
  - + Indicates an upgrade with the difference of 1 between the previous and current rating. For example, from 3.2 (Hold) to 2.2 (Buy).
  - ++ Indicates an upgrade with the difference of 2 between the previous and current rating. For example, from 5 (Strong Sell) to 3 (Hold).
  - +++ Indicates an upgrade with the difference of 3 between the previous and current rating. For example, from 4.8 (Strong Sell) to 1.8 (Buy).
  - ++++ Indicates an upgrade with the difference of 4 between the previous and current rating, from 5 (Strong Sell) to 1 (Strong Buy).
  - - Indicates a downgrade with the difference of -1 between the previous and current rating. For example, from 2.9 (Hold) to 3.9 (Sell).
-- Indicates a downgrade with the difference of -2 between the previous and current rating. For example, from 1.5 (Buy) to 3.5 (Sell).

--- Indicates a downgrade with the difference of -3 between the previous and current rating. For example, from 1 (Strong Buy) to 4 (Sell).

---- Indicates a downgrade with the difference of -4 between the previous and current rating, from 1 (Strong Buy) to 5 (Strong Sell).

+< Indicates an upgrade with the positive (from 0.1 to 0.9) difference between the previous and current rating. (For example, if the previous rating for a stock was 3.3 (Sell), and the subsequent rating is 2.5 (Hold), the difference (3.3-2.5) is a positive 0.8).

—< Indicates a downgrade with the negative (from -0.9 to -0.1) difference between the previous and current rating. For example, if the previous rating for a stock was 1.3 (Buy), and the subsequent rating is 2.0 (Buy), the difference (1.3-2.0) is a negative 0.7.

NEW Denotes the initial recommendations issued by an analyst for the stock.

- Win (%) – Analyst’s historical recommendation accuracy calculated as the percent of the selected analyst's buy or sell recommendations that outperformed an equal weighted industry index.

- Rating Date - date of the recommendation or a revision date.

The Full Universe parameter is not available for this report.

**Top Analyst Recommendations**

This report provides recommendations from the historically most accurate analysts for each stock in your portfolio.

Zacks uses two measures to evaluate an analyst's ability to rate stocks — "Win Percentage" and "Excess Return". A Win is recorded for each analyst's recommendation that beats the performance of an equal weighted industry index for all buy and sell ratings. Ties are broken by measuring how much the average buy recommendation was in excess of the average industry performance.

In addition to the analysts' historical accuracy (Win%), this report also includes ratings, ratings changes, and rating dates (see the Change in Analyst Recommendations report description for explanation of these items).

The Full Universe parameter is not available for this report.

**Estimate Revisions Category**

**Recent Consensus EPS Revisions**

This report displays the consensus EPS estimates along with the percentage change in the consensus EPS for stocks in your portfolio or universe. You can view changes for a specified fiscal quarter or fiscal year. Also included in the report is the fiscal quarter or fiscal year end date.
**Recent Analyst EPS Revisions**

This report shows individual analysts’ quarterly or annual EPS estimates along with the percent change in their EPS estimates for every stock in your portfolio over a specified time period. Also included in the reports is the reported period end date and the date of the estimate (or a revision date).

The **Full Universe** parameter is not available for this report.

**EPS Surprise Category**

**Reported EPS Surprises**

This report shows quarterly earnings surprises for the stocks in your portfolio or universe over a specified time period. EPS Surprise is calculated as 

\[
\left( \frac{\text{Actual EPS} - \text{Consensus EPS}}{\text{Absolute value of Consensus EPS}} \right) \times 100
\]

(Expressed in percent).

Additional information provided by this report includes quarter end month, Actual EPS, Consensus EPS, and EPS report date.

**Expected Report Date**

This report shows the date when a company is expected to announce its earnings. You can check the expected report dates for the companies in your portfolio or universe. In addition to the expected report date, this report also includes quarter end month, and the variability of the report date (the average historical variance in days). The report also provides the source of the expected report date:

- Default - Last year's quarter ended date.
- Estimate - Zacks estimate of the most likely quarter ending date.

**Predicting Next Surprise - Most Accurate Analysts**

This report forecasts potential EPS surprises in the next several days (you can specify the number of days: 5, 30, 60, etc.). This report predicts earnings surprises by exploiting the differences between the most accurate analysts’ EPS consensus and the general consensus estimate (on a quarterly basis).

Zacks' methodology for identifying the most accurate analysts is based on computing the historical errors of an analyst. The error is calculated as the actual EPS minus the quarter end estimate. Analysts with the smallest errors are considered to be the best analysts. Then analysts are ranked based on a historical average of the absolute error for the two most recently reported quarter end forecasts, with the smallest errors being the best.

The expected surprise in this report is calculated as 

\[
\left( \frac{\text{Most Accurate Consensus Estimate} - \text{Consensus Estimate}}{\text{Consensus Estimate}} \right) \times 100 \%
\]

The potential surprises are then "normalized" (divided by the Standard Deviation of Consensus) and ranked. This rank is determined as 

\[
\left( \frac{\text{Most Accurate Consensus} - \text{Consensus Estimate}}{\text{Standard Deviation of Consensus}} \right)
\]

The higher the Surprise Rank, the more there is a potential for a surprise.

Additional information provided by this report includes: quarter end month, number of estimates for each company, and expected report date.
Predicting Next Surprise - Most Recent Analysts

This report forecasts potential EPS surprises in the next several days (you can specify the number of days: 5, 30, 60, etc.). This report predicts surprises by exploiting the difference between the most recent analysts' EPS consensus and the general consensus estimate (on a quarterly basis).

The expected surprise in this report is calculated as 
\[
\frac{(\text{Most Recent Consensus Estimate} - \text{Consensus Estimate})}{\text{Consensus Estimate}} \times 100\%.
\]

The potential surprises are then "normalized" (divided by the Standard Deviation of Consensus) and ranked. This rank is determined as 
\[
\frac{(\text{Most Recent Consensus} - \text{Consensus Estimate})}{\text{Standard Deviation of Consensus}}.
\]

The higher the Surprise Rank, the more there is a potential for a surprise.

Additional information provided by this report includes: quarter end month, number of estimates for each company, and expected report date.

Standardized Unexpected Earnings

The important surprises are those associated with forecast errors that are large by historical standards. To account for this, a forecast error can be related to previous errors by meanings of Standardized Unexpected Earnings (SUE).

SUE effectively minimizes the earnings surprise in a particular quarter by a measure of the typical surprise in an average quarter. This discounts forecast errors for firms with historically very unpredictable earnings. A large error for such a firm might not be as significant as for a firm with typically very predictable earnings.

This report rates companies by Standardized Unexpected Earnings - (SUE) - a measurement of the deviation of 12-month actual EPS from the 5-year EPS growth trend line.

Today's Reported EPS Surprises

Several times a day, as information on reporting companies becomes available, Zacks updates the surprise file (up to eight times a day). At the end of the day, this information will be consolidated into the daily surprise file.

In this report, EPS Surprise is expressed in percent and is calculated as 
\[
\frac{(\text{Actual EPS} - \text{Consensus EPS})}{\text{Absolute value of Consensus EPS}} \times 100.
\]

Additional information provided by this report includes quarter end month, Actual EPS, Consensus Estimate, Net Income and Sales numbers, and EPS report date.

Upside Potential Category

Most Accurate Consensus

This report indicates quarterly and annual EPS surprises based on the most accurate estimates. This report takes into consideration the difference between the general consensus estimate and the most accurate analysts' EPS consensus for the fiscal period.

The most accurate EPS consensus is computed by ranking the analysts' historical performance. Zacks' methodology for identifying the most accurate analysts is based on computing the historical errors of an analyst. Analysts with the smallest errors are considered to be the best analysts. The analysts
are ranked based on a historical average of their errors, with the smallest errors being the best.

The most accurate quarterly consensus is computed by ranking the average of the analysts' absolute errors for the last two quarters.

The criteria for annual analyst EPS accuracy is the average number of month end forecasts during the past four years when the analyst's annual EPS absolute forecast error was less than the absolute consensus error for the year.

The expected surprise in this report is calculated as \[
\frac{\text{(Most Accurate Consensus Estimate} - \text{Consensus Estimate})}{\text{Consensus Estimate}} \times 100\%
\]

The potential surprises are then "normalized" (divided by the Standard Deviation of Consensus) and ranked. This rank is determined as \[
\frac{\text{(Most Accurate Consensus} - \text{Consensus Estimate})}{\text{Standard Deviation of Consensus}}
\]. The higher the Surprise Rank, the more there is a potential for a surprise.

Additional information provided by this report includes: fiscal period end month, number of estimates for each company, and expected report date.

**Most Recent Consensus**

This report highlights potential quarterly and annual EPS surprises based on the most recent estimates. This report takes into considerations the difference between the general consensus estimate and the most recent analysts' EPS consensus.

The surprise is calculated as \[
\frac{\text{(Most Recent Consensus Estimate} - \text{Consensus Estimate})}{\text{Consensus Estimate}} \times 100\%
\]

The potential surprises are then "normalized" (divided by the Standard Deviation of Consensus) and ranked. This rank is determined as \[
\frac{\text{(Most Recent Consensus} - \text{Consensus Estimate})}{\text{Standard Deviation of Consensus}}
\]. The higher the Surprise Rank, the more there is a potential for a surprise.

Additional information provided by this report includes: fiscal period end month, number of estimates for each company, and expected report date.

By default this report is sorted from highest positive to the biggest negative Surprise Rank value.

**Price Action Category**

**Price Changes**

This report shows the percent price change during a specified time period for stocks in your portfolio or universe. This report also includes percent price change relative to the S&P 500, 52-week high/low data and the closing price as of the prior's day last trade.

**Intraday Price Changes**

This reports monitors the following Intraday price changes for the stocks in your portfolio: % Price Change, Net Price Change, Last Trade, Update Time, Open and High.
Snapshot Reports

Snapshot Report Options

Click the Snapshot button from the Research Wizard display to access the Company Reports menu. There you can perform several tasks:

- Access Zacks Company Snapshot
- Access Expanded Company Reports
- Access Zacks Integrated Company Analysis application
- Print Snapshot for Active Tickers

Working with Zacks Company Snapshot

The Zacks Company Snapshot is a single company report featuring company description, actual and estimated EPS, company vs. industry ratings, fundamental data, broker recommendations and price charts.

Accessing Zacks Company Snapshot

To access Zacks Company Snapshot, follow these steps:

1. At the Research Wizard main menu, click the Snapshot button.
2. At the Company Reports menu, type a ticker symbol into the Enter Ticker box and check the Zacks Company Snapshot radio button.
3. Click OK to display the report.
Printing Zacks Company Snapshot Reports for Active Tickers

You can print Zacks Company Snapshot report for tickers that passed your screen or are in your Active Ticker List.

To print Snapshot reports for all tickers that passed your screen, follow these steps:

1. After specifying screening criteria, click Run Query and get the desired universe.
2. Return to the main menu, and click Snapshot.
3. At the Company Reports menu, click Print Snapshot for Active Tickers.
4. The message will appear stating how many company reports will be printed. Select Yes to print them or No to cancel.

To print Snapshot reports for a portfolio, follow these steps:

1. Select a Ticker List (its name will be displayed in the Screening Criteria table).
2. At the Company Reports menu, click Print Snapshot for Active Tickers.
3. The message will appear stating how many company reports will be printed. Select Yes to print them or No to cancel.

Zacks Company Snapshot Report Overview

Zacks Company Snapshot is a single company report featuring company description, actual and estimated EPS, company vs. industry ratings, fundamental data, broker recommendations and price charts.

Zacks Company Snapshot Report Components

Company Summary Table and Business Description

The most commonly referred-to pieces of data on a stock are located near the top of the report for easy references. Items here include company name, ticker symbol and the Exchange on which the stock is traded, price, P/E ratio
(trailing twelve months), Market Capitalization, Industry, company type, current dividend rate and Dividend Yield, 12 month sales, growth rates for sales, EPS, and dividends for the past five years and Zacks Performance Ranking.

Zacks Performance Rank - Research has shown that one of the most powerful forces driving a stock performance is change in earnings estimates from brokerage analysts. The Zacks Rank (also called Zacks Rating) is a
short-term trading indicator based primarily on the momentum of revisions in analysts' earnings estimates. The ranking — ranging from 1 (Strong Buy) to 5 (Strong Sell) — has been shown to be an accurate predictor of stock price performance (relative to the market) for the coming 90-180 days.

**Company Type** - The company type is based on its Market Cap and Price/Book ratio.

<table>
<thead>
<tr>
<th>Market Cap</th>
<th>Price/Book</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt; $800 mil – Small</td>
<td>&lt; 1.75 – Value</td>
</tr>
<tr>
<td>&gt; $3500 mil – Large</td>
<td>&gt; 3.5 – Growth</td>
</tr>
<tr>
<td>&gt; $800 mil and &lt; $3500 mil – Mid</td>
<td>&gt; 1.75 and &lt; 3.5 – Blend</td>
</tr>
</tbody>
</table>

**Business Description**

A brief business description is provided beneath the summary table.

**Broker Recommendations Data and Charts**

The Average Broker Recommendation is highlighted and the number of analysts who have revised their opinion of the stock up or down in the past four weeks is noted. The recommendations, which are updated continuously based on information Zacks receives from brokerages firms, are broken into five categories: Strong Buy, Buy, Hold, Sell, Strong Sell. The convenient histogram format allows you get a quick feel for both the number of analysts actively following the stock and their opinions about the stock's relative attractiveness.

**Price/Volume Data**

This section of the report includes data indicating the stock's price range over the last 52 weeks as well as year-to-date price change for the stock and its performance relative to the S&P 500. The average daily trading volume for the last 20 trading days is also provided.

**Expected Return/Market Risk**

**Implied Return**

The stock's implied return is calculated by adding a stock's current dividend yield to its estimated long-term EPS growth rate. The implied return is a handy performance measure which could approximate the total annual return (including dividends and capital appreciation) an investor might achieve over the next several years provided the projected growth on EPS actually materializes and the P/E ratio does not change.

**Beta**

A stock's Beta is a statistical measure of its sensitivity to past market movements. A stock with a beta of 1.5 has historically seen its price move (up or down) one and one-half times the percentage change in the broader equity market.

**Shareholder Data**

This section includes data on the number of shares outstanding and the percentage owned by Inside Management and Institutional Investors. Some Institutional sponsorship is desirable because these large investors typically trade large blocks of stocks that can result in significant upward price movements. However, too high a level of Institutional ownership can increase a stock's downside risk because these large shareholders represent potential...
sellers if something goes wrong at the company. Significant ownership by corporate insiders is considered favorable because management's interests are then more closely aligned with other shareholders.

**Fundamental and Technical data**

**EPS, P/E and Growth Rates**

This section summarizes the company's recent Actual and Estimated EPS, P/E and Year-to-Year EPS Growth Rates.

**Current and 5-year Average Data**

This section includes five key measures as they stand currently versus historically (average of the last five years). These measures are: P/E ratio (trailing 12 months), P/E ratio relative to the S&P 500, Net Margin, Return on Equity (ROE), and the Long-Term Debt To Capitalization Ratio - a key indicator of financial risk. Stocks trading below (above) their historical P/E and relative P/E ratios may be cheap (expensive) unless there have been fundamental changes in the company's growth prospects. Similarly, changes in a company's profitability or capital structure from previous norms are important to note.

**Actual EPS and EPS Estimates vs. Stock Price Chart**

The chart at the center of the Snapshot report plots the stock price versus the 12-month earnings per share. The chart includes fiscal year-end data going back five years, quarter-end data for the last four and next two quarters, and estimated earnings projected 1, 2 and 3-5 years out. While not intended for use as a technical analysis tool, the price chart provides a visual representation of how the stock has been trading relative to its past growth in earnings as well as how Wall Street perceives its future earnings growth prospects.

**EPS Surprises and Estimate Revisions Chart**

A plot of the EPS surprises for the last four quarters and the 12 week earnings estimate revisions for the current and next fiscal years are shown in a bar graph below the price chart. Earnings surprises are the percentage by which a company's earnings exceed or fall short of the consensus estimates for a company on the EPS report date.

**Company vs. Industry Comparison**

The table at the bottom of the Snapshot report provides an overview of how a company measures up against its industry peers and the overall market on a number of key measures. Data includes year-to-date price change, P/E (12 month), estimated 3-5 year EPS growth rate, Price/Book, Price/Sales, Price/Cash Flow, implied return to P/E ratio, dividend yield, Net Margin, ROE, and Debt/Capital.

The industry comparable data is most useful for relatively homogeneous industries. Zacks large number of industry classifications (over 200) helps to insure comparability between companies.

**Working with Expanded Company Reports**

The Expanded Company Reports, displayed in your browser, give you the access to the company’s fundamental data, insiders data, and company's general information.
Accessing Expanded Company Reports

To run an Expanded Company Report, follow these steps:

1. Click the Snapshot button at the Research Wizard main menu.
2. At the Company Reports menu, type a ticker symbol into the Enter Ticker box.
3. Check the Expanded Company Reports radio button, select a report from the reports pull-down menu, and click OK.
4. Your default browser will be launched and the report will be displayed. To switch between your browser and the Research Wizard, click the Research Wizard button on your Windows taskbar.

Expanded Company Reports Categories

There are several expanded company reports available in Research Wizard. These reports can be classified into several categories:

- Fundamental (Income Statement, Balance Sheet, and Cash Flow tables)
- Return on Equity
- Risk Rating/Bankruptcy
- Business Description & Management Discussion
- Insider Trading

Fundamental Reports

Income Statement, Balance Sheet, and Cash Flow tables

There are several Income Statement, Balance Sheet, and Cash Flow tables (presented annually for the last 5 years and quarterly for the last 8 quarters) available in this category of the reports.

Please note that the line items shown in these tables may not exactly match the line items on the 10-K and 10-Q reported by the company, as Zacks has standardized a number of items to facilitate comparison between companies.

The reports in this category include:

- Annual Cash Flow Statement — standardized report containing data from 10K filings.
- Annual Income Statement — standardized report containing data from 10K filings.
- Annual Balance Sheet — standardized report containing data from 10K filings.
- Quarterly Balance Sheet — standardized report containing data from 10Q filings.
- Quarterly Income Statement — standardized report containing data from 10Q filings.
- Annual Ratios & Turnover Rates — Assets/Liabilities ratios, turnover rates and sales ratios.
- Quarterly Ratios & Turnover Rates — Assets/Liabilities ratios, turnover rates and sales ratios.
Return on Equity Reports

There are two Return on Equity reports, presented annually for the last 5 years and quarterly for the last 8 quarters. These reports use the extended DuPont model (ROE Decomposition).

The ROE Decomposition model measures company's profitability and helps to relate and interpret the financial ratios for asset management, debt management and profitability. It also calculates return on shareholder equity:

\[ \text{ROE} = \text{After Tax Profit Margin} \times \text{Total Asset Turnover} \times \text{Equity Multiplier} \]

The reports in this category include:

- Annual Return on Equity - ROE Decomposition - 5 years.
- Quarterly Return on Equity - ROE Decomposition - 8 quarters.

Risk Rating/Bankruptcy Reports

In addition, we have included two Risk Rating/Bankruptcy reports, presented annually for the last 5 years and quarterly for the last 8 quarters. These reports show what the company would be worth upon liquidation. The Net Liquidation Value is the amount that could be realized by selling the assets of a firm after paying the debt.

The reports in this category include:

- Quarterly Risk Rating/Bankruptcy Report - displays quarterly growth rates and components of the Net Liquidation Value.

Business Description & Management Discussion Reports

Business Descriptions Reports

A complete overview of the business of the company from the last 10-K filings.

Management's Discussion and Analysis Reports

Management's Discussion and Analysis report (Management's Discussion and Analysis of Financial Condition and Results of Operations) is a report from management to the shareholders that accompanies the firm's financial statements in the annual report. This report explains the period's financial results and enables management to discuss other ideas that may not be apparent in the financial statements in the annual report.

Insider Trading Report

The most recent insider transactions, as reported to the SEC, are summarized here. Insiders include major corporate officers, members of the board of directors, and owners of 10% or more of any equity class of securities.
Link to Integrated Company Analysis

If you have the Zacks product, Integrated Company Analysis (ICA), you can have an instantaneous link to that module.

To access ICA from the Research Wizard, follow these steps:

1. Click the Snapshot button from the Research Wizard display to access the Company Reports menu.
2. At the Company Reports menu, type a ticker symbol into the Enter Ticker box.
3. Select the Integrated Company Analysis radio button and click OK.
4. ICA will open in a separate window. To switch back to the Research Wizard, click the Research Wizard button on your Windows taskbar.
### List of Zacks Sector and Industry Designations

The following is a list of Zacks X (Expanded) Industries, Zacks Sectors, and Zacks M (Medium) Industries designations.

#### Zacks X (Expanded) Sector Groups

<table>
<thead>
<tr>
<th>Code</th>
<th>Industry</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Indices</td>
</tr>
<tr>
<td>1</td>
<td>Consumer Staples</td>
</tr>
<tr>
<td>2</td>
<td>Consumer Discretionary</td>
</tr>
<tr>
<td>3</td>
<td>Retail-Wholesale</td>
</tr>
<tr>
<td>4</td>
<td>Medical</td>
</tr>
<tr>
<td>5</td>
<td>Auto-Tires-Trucks</td>
</tr>
<tr>
<td>6</td>
<td>Basic Materials</td>
</tr>
<tr>
<td>7</td>
<td>Industrial Products</td>
</tr>
<tr>
<td>8</td>
<td>Construction</td>
</tr>
<tr>
<td>9</td>
<td>Conglomerates</td>
</tr>
<tr>
<td>10</td>
<td>Computer and Technology</td>
</tr>
<tr>
<td>11</td>
<td>Aerospace</td>
</tr>
<tr>
<td>12</td>
<td>Oils-Energy</td>
</tr>
<tr>
<td>13</td>
<td>Finance</td>
</tr>
<tr>
<td>14</td>
<td>Utilities</td>
</tr>
<tr>
<td>15</td>
<td>Transportation</td>
</tr>
<tr>
<td>16</td>
<td>Business Services</td>
</tr>
<tr>
<td>17</td>
<td>Unclassified</td>
</tr>
</tbody>
</table>

#### Zacks M (Medium) Industry Groups

<table>
<thead>
<tr>
<th>Code</th>
<th>Industry</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>INDICES</td>
</tr>
<tr>
<td>1</td>
<td>APPAREL</td>
</tr>
<tr>
<td>2</td>
<td>BEVERAGES</td>
</tr>
<tr>
<td>3</td>
<td>FOOD</td>
</tr>
<tr>
<td>4</td>
<td>PUBLISHING</td>
</tr>
<tr>
<td>5</td>
<td>SOAPS-COSMETICS</td>
</tr>
<tr>
<td>6</td>
<td>TOBACCO</td>
</tr>
<tr>
<td>7</td>
<td>CONS PROD-MISC STAPLES</td>
</tr>
<tr>
<td>8</td>
<td>HOME FURNISHING-APPLIANCE</td>
</tr>
<tr>
<td>9</td>
<td>LEISURE SERVICE</td>
</tr>
<tr>
<td>10</td>
<td>MEDIA</td>
</tr>
<tr>
<td>11</td>
<td>PHOTO EQUIPMENT &amp; SUPPLIES</td>
</tr>
<tr>
<td>12</td>
<td>OTHER CONSUMER DISCRETIONARY</td>
</tr>
<tr>
<td>13</td>
<td>FOOD/DRUG-RETAIL/WHOLESALE</td>
</tr>
<tr>
<td>14</td>
<td>NONFOOD RETAIL-WHOLESALE</td>
</tr>
<tr>
<td>15</td>
<td>DRUGS</td>
</tr>
<tr>
<td>16</td>
<td>MEDICAL CARE</td>
</tr>
<tr>
<td>17</td>
<td>MEDICAL PRODUCTS</td>
</tr>
<tr>
<td>18</td>
<td>AUTOS-TIRES-TRUCKS</td>
</tr>
<tr>
<td>19</td>
<td>CHEMICALS &amp; FERTILIZER</td>
</tr>
<tr>
<td>20</td>
<td>METALS-NON FERROUS</td>
</tr>
<tr>
<td>21</td>
<td>STEEL</td>
</tr>
<tr>
<td>22</td>
<td>PAPER</td>
</tr>
<tr>
<td>23</td>
<td>CONTAINERS &amp; GLASS</td>
</tr>
<tr>
<td>24</td>
<td>INDUSTRIAL PRODUCTS-SERVICES</td>
</tr>
<tr>
<td>25</td>
<td>MACHINERY-ELECTRICAL</td>
</tr>
<tr>
<td>26</td>
<td>MACHINERY</td>
</tr>
<tr>
<td>27</td>
<td>POLLUTION CONTROL</td>
</tr>
<tr>
<td>28</td>
<td>BUILDING PRODUCTS</td>
</tr>
<tr>
<td>29</td>
<td>CONSTRUCTION-BUILDING SERVICES</td>
</tr>
<tr>
<td>30</td>
<td>CONglomerates</td>
</tr>
<tr>
<td>31</td>
<td>COMPUTER-OFFICE EQUIPMENT</td>
</tr>
<tr>
<td>32</td>
<td>COMPUTER SOFTWARE-SERVICES</td>
</tr>
<tr>
<td>33</td>
<td>ELECTRONIC-SEMICONDUCTORS</td>
</tr>
<tr>
<td>34</td>
<td>ELECTRONICS</td>
</tr>
<tr>
<td>35</td>
<td>MISC TECHNOLOGY</td>
</tr>
<tr>
<td>36</td>
<td>TELECOMMUNICATIONS EQUIPMENT</td>
</tr>
<tr>
<td>37</td>
<td>TELECOMMUNICATIONS SERVICES</td>
</tr>
<tr>
<td>38</td>
<td>AEROSPACE-DEFENSE</td>
</tr>
<tr>
<td>39</td>
<td>COAL</td>
</tr>
<tr>
<td>40</td>
<td>ENERGY-ALTERNATE SOURCES</td>
</tr>
<tr>
<td>41</td>
<td>OIL MACHINERY-SERVICES-DRILLING</td>
</tr>
<tr>
<td>42</td>
<td>OIL-EXPLORATION&amp;PRODUCTION</td>
</tr>
<tr>
<td>43</td>
<td>OIL-MISC</td>
</tr>
<tr>
<td>44</td>
<td>OIL-INTEGRATED</td>
</tr>
<tr>
<td>45</td>
<td>OIL&amp;GAS PRODUCTION-PIPELINE</td>
</tr>
<tr>
<td>46</td>
<td>BANKS-MAJOR</td>
</tr>
<tr>
<td>47</td>
<td>BANKS &amp; THRIFTS</td>
</tr>
<tr>
<td>48</td>
<td>FINANCE</td>
</tr>
<tr>
<td>49</td>
<td>INSURANCE</td>
</tr>
<tr>
<td>50</td>
<td>INVEST BKRS-MGRS</td>
</tr>
<tr>
<td>51</td>
<td>INVESTMENT FUND</td>
</tr>
<tr>
<td>52</td>
<td>REAL ESTATE</td>
</tr>
<tr>
<td>53</td>
<td>UTILITY-ELEC PWR</td>
</tr>
<tr>
<td>54</td>
<td>UTILITY-GAS DISTR</td>
</tr>
<tr>
<td>55</td>
<td>UTILITY-TELEPHONE</td>
</tr>
<tr>
<td>56</td>
<td>UTILITY-WATER SUPPLY</td>
</tr>
<tr>
<td>57</td>
<td>TRANSPORTATION-AIR</td>
</tr>
<tr>
<td>58</td>
<td>TRANSPORTATION</td>
</tr>
<tr>
<td>59</td>
<td>BUSINESS SERVICE</td>
</tr>
<tr>
<td>70</td>
<td>UNCLASSIFIED</td>
</tr>
</tbody>
</table>
### Zacks X (Expanded) Industry Groups

<table>
<thead>
<tr>
<th></th>
<th>1 ADVERTISING</th>
<th>55 ELEC-MILITARY</th>
<th>109 MED-HOSPITALS</th>
<th>163 RETAIL-MAIL ORD</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>2 AEROSP/DEFENSE</td>
<td>56 ENERGY-ALT SRCS</td>
<td>110 MED-NURSING HMS</td>
<td>164 RETAIL-MJR DEPT</td>
</tr>
<tr>
<td>3</td>
<td>3 AEROSP/DEF EQ</td>
<td>57 ENGNERG/R&amp;D SVS</td>
<td>111 MED-OUTP/HM CRE</td>
<td>165 RETAIL-MISC/DIV</td>
</tr>
<tr>
<td>4</td>
<td>4 AGRI OPERATIONS</td>
<td>58 ENGINES-INT CMB</td>
<td>112 MED-WHSL DRG/SN</td>
<td>166 RETAIL- RGN CTY</td>
</tr>
<tr>
<td>5</td>
<td>5 APPLIANCE-HSHLD</td>
<td>59 FERTILIZERS</td>
<td>113 MED/DENTAL-SUPP</td>
<td>167 RETAIL-SUPERMKT</td>
</tr>
<tr>
<td>6</td>
<td>6 AUDIO/VIDEO PRD</td>
<td>60 FILTER OPTICS</td>
<td>114 MINING -GOLD</td>
<td>168 RETAIL-VENDING</td>
</tr>
<tr>
<td>7</td>
<td>7 AUTO -DOMESTIC</td>
<td>61 FIN-CONS LOANS</td>
<td>115 MINING -IRON</td>
<td>169 RETAIL-WHSL CMP</td>
</tr>
<tr>
<td>8</td>
<td>8 AUTO -FOREIGN</td>
<td>62 FIN-INVEST BKRS</td>
<td>116 MINING -MISC</td>
<td>170 RUBBER&amp;PLASTICS</td>
</tr>
<tr>
<td>9</td>
<td>9 RET/WHL-AUTO PT</td>
<td>63 FIN-INVEST MGMT</td>
<td>117 MINING -NON FERR</td>
<td>171 RUBBER-TIRES</td>
</tr>
<tr>
<td>10</td>
<td>10 AUTO/TRUCK-ORIG</td>
<td>64 FIN-LEASING COS</td>
<td>118 MINING -SILVER</td>
<td>172 SCHOOLS</td>
</tr>
<tr>
<td>11</td>
<td>11 AUTO/TRUCK-REPL</td>
<td>65 FIN-MTG&amp;REL SVS</td>
<td>119 METAL PROC&amp;FABR</td>
<td>173 SHOES&amp;REL APPPR</td>
</tr>
<tr>
<td>12</td>
<td>12 BANKS-FOREIGN</td>
<td>66 FIN-INVEST MGMT</td>
<td>120 METAL PRD-DISTR</td>
<td>174 SOAP&amp;CLNG PREPS</td>
</tr>
<tr>
<td>13</td>
<td>13 BANKS-MIDWEST</td>
<td>67 FIN-SVGS &amp; LOAN</td>
<td>121 METAL PRD-FSTRS</td>
<td>175 STEEL-Pipe&amp;TUBE</td>
</tr>
<tr>
<td>14</td>
<td>14 BANKS-MONEY CTR</td>
<td>68 FIN-SBIC&amp;COMMRL</td>
<td>122 MOVIE/TV PROD/DISTR</td>
<td>176 STEEL-PRODUCERS</td>
</tr>
<tr>
<td>15</td>
<td>15 BANKS-NORTHEAST</td>
<td>69 FIN-MISC SVCS</td>
<td>123 CON PRD-MISC DISCR</td>
<td>177 STEEL-SPECIALTY</td>
</tr>
<tr>
<td>16</td>
<td>16 BANKS-SOUTHEAST</td>
<td>70 FOOD ITEMS-WHLE</td>
<td>124 OFFICE AUTO&amp;EQP</td>
<td>178 TELECOMM SVCS</td>
</tr>
<tr>
<td>17</td>
<td>17 BANKS-SOUTHWEST</td>
<td>71 FOOD-CANNED</td>
<td>125 OFFICE SPLL&amp;FRM</td>
<td>179 TELECOMM EQIP</td>
</tr>
<tr>
<td>18</td>
<td>18 BANKS-WEST</td>
<td>72 FOOD-CONFECTNRY</td>
<td>126 OIL-US RLYLY TR</td>
<td>180 TEXTILE-APPAREL</td>
</tr>
<tr>
<td>19</td>
<td>19 BEVERAGES-ALCOH</td>
<td>73 FOOD-DAIRY PRDS</td>
<td>127 OIL FLD MCH&amp;EQP</td>
<td>181 TEXTILE-HME FRN</td>
</tr>
<tr>
<td>20</td>
<td>20 BEVERAGES-SOFT</td>
<td>74 FOOD-FLOR&amp;GRN</td>
<td>128 OIL REFINI&amp;MTK</td>
<td>182 TEXTILE-PRODUCTS</td>
</tr>
<tr>
<td>21</td>
<td>21 BLDG&amp;CONST-MISC</td>
<td>75 FOOD-MEAT PRODS</td>
<td>129 OIL-C$ EXP&amp;PROD</td>
<td>183 TOBACCO</td>
</tr>
<tr>
<td>22</td>
<td>22 BLDG-PRD-AIR/HT</td>
<td>76 FOOD-MISC/DIVERS</td>
<td>130 OIL-C$ INTEGRD</td>
<td>184 TOOLS-HAND HELD</td>
</tr>
<tr>
<td>23</td>
<td>23 BLDG-PRD-DRS&amp;TR</td>
<td>77 FOOD-SUGAR&amp;REFG</td>
<td>131 OIL-FIELD SVCS</td>
<td>185 TOYS/GAME/HOBBY</td>
</tr>
<tr>
<td>24</td>
<td>24 BLDG-PRD-LGT FX</td>
<td>78 FURNITURE</td>
<td>132 OIL-INTL INTGD</td>
<td>186 AUTO-TRK CTY</td>
</tr>
<tr>
<td>25</td>
<td>25 BLDG-PRD-SOUND</td>
<td>79 FURNITURE</td>
<td>133 OIL-INTC SPCLTY</td>
<td>187 AUTO-TRCI</td>
</tr>
<tr>
<td>26</td>
<td>26 BLDG-PRD-WOOD</td>
<td>80 GLASS PRODUCTS</td>
<td>134 OIL&amp;GAS-DRILL</td>
<td>188 AUTO-EQ&amp;PALNSG</td>
</tr>
<tr>
<td>27</td>
<td>27 BLDG-CMT/CNT/AG</td>
<td>81 HOTELS &amp; MOTELS</td>
<td>135 OIL-PRD/PIPILN</td>
<td>189 AUTO-RAIL</td>
</tr>
<tr>
<td>28</td>
<td>28 BLDG-HEAVY CNST</td>
<td>82 INDL AUTO/RBCTS</td>
<td>136 OIL-US EXP&amp;PROD</td>
<td>190 AUTO-TRK CTY</td>
</tr>
<tr>
<td>29</td>
<td>29 BLDG-MAINT &amp; SV</td>
<td>83 INSTRU-CONTROL</td>
<td>137 OIL-US INTEGRD</td>
<td>191 AUTO-TRK CTY</td>
</tr>
<tr>
<td>30</td>
<td>30 BLDG-MBF/AVL</td>
<td>84 INSTRU-SCIENTFC</td>
<td>138 COMP-OPTICL REC</td>
<td>192 AUTO-TRK CTY</td>
</tr>
<tr>
<td>31</td>
<td>31 BLDG-RSDNT/COM</td>
<td>85 INS-ACC &amp; HLTH</td>
<td>139 PAINTS&amp;REL PRDS</td>
<td>193 AUTO-TRC</td>
</tr>
<tr>
<td>32</td>
<td>32 BRCST-RADIO/TV</td>
<td>86 INS-BROKERS</td>
<td>140 PAPER &amp;REL PRDS</td>
<td>194 AUTO-MIRL</td>
</tr>
<tr>
<td>33</td>
<td>33 CABLE TV</td>
<td>87 INS-LIFE</td>
<td>141 PAPER-BUS FORMS</td>
<td>195 AUTO-SLEEP</td>
</tr>
<tr>
<td>34</td>
<td>34 CHEM-DIVERSIFD</td>
<td>88 INS-MULTI LINE</td>
<td>142 PHOTO EQP &amp;SUPP</td>
<td>196 AUTO-WATER SPLY</td>
</tr>
<tr>
<td>35</td>
<td>35 CHEM-FIBERS</td>
<td>89 INS-PROP&amp;CASTLY</td>
<td>143 POLLUTION CNTRL</td>
<td>197 AUTO-WATER SPLY</td>
</tr>
<tr>
<td>36</td>
<td>36 CHEM-PLASTICS</td>
<td>90 LASERS-SYS/COMP</td>
<td>144 PREC MTLS/JWLRY</td>
<td>198 AUTO-WEATHER</td>
</tr>
<tr>
<td>37</td>
<td>37 CHEM-POLICY</td>
<td>91 LEISURE&amp;REC PRD</td>
<td>145 PRINTING-COMRL</td>
<td>199 AUTO-WEATHER</td>
</tr>
<tr>
<td>38</td>
<td>38 COAL</td>
<td>92 LEISURE&amp;REC SVS</td>
<td>146 PROTECTION-SFTY</td>
<td>200 AUTO-WEATHER</td>
</tr>
<tr>
<td>39</td>
<td>39 COMP-GRAFICS</td>
<td>93 LINEN SPLY &amp;REL</td>
<td>147 PUBLSHG-BOOKS</td>
<td>200 AUTO-WEB</td>
</tr>
<tr>
<td>40</td>
<td>40 COMP-MAINFRAME</td>
<td>94 MACH-TLSRL PRD</td>
<td>148 PUBLSHG-NEWSPRS</td>
<td>200 AUTO-WEB</td>
</tr>
<tr>
<td>41</td>
<td>41 COMP-MICRO</td>
<td>95 MACH-VISUALS</td>
<td>149 PUBLISHG-PDCLALS</td>
<td>200 AUTO-WEB</td>
</tr>
<tr>
<td>42</td>
<td>42 COMP-PERP</td>
<td>96 MACH-ELEC UTILS</td>
<td>150 REIT-EGTY TRUST</td>
<td>200 AUTO-WEB</td>
</tr>
<tr>
<td>43</td>
<td>43 COMP-SERVICES</td>
<td>97 MACH-ELECTRICAL</td>
<td>151 REIT-MTGE TRUST</td>
<td>200 AUTO-WEB</td>
</tr>
<tr>
<td>44</td>
<td>44 COMP-SOFTWARE</td>
<td>98 MACH-FARM</td>
<td>152 REAL ESTATE DEV</td>
<td>200 AUTO-WEB</td>
</tr>
<tr>
<td>45</td>
<td>45 CONTRNS-MT/LGS</td>
<td>99 MACH-HNRL HSLS</td>
<td>153 REAL ESTATE OPS</td>
<td>200 AUTO-WEB</td>
</tr>
<tr>
<td>46</td>
<td>46 CONTRNS-PPL/POLS</td>
<td>100 MACH-MATL HDLS</td>
<td>154 REALT-APP/SHOE</td>
<td>200 AUTO-WEB</td>
</tr>
<tr>
<td>47</td>
<td>47 COSMETICS&amp;TLYR</td>
<td>101 MACH-PRINT TRAD</td>
<td>155 REALT-CATLG SH</td>
<td>200 AUTO-WEB</td>
</tr>
<tr>
<td>48</td>
<td>48 DIVERSIFIED OPS</td>
<td>102 MACH-THRML PROC</td>
<td>156 REALT-CONS ELC</td>
<td>200 AUTO-WEB</td>
</tr>
<tr>
<td>49</td>
<td>49 ELECT COMP-SEMIC</td>
<td>103 MED INSTRUMENTS</td>
<td>157 REALT-CONV STRS</td>
<td>200 AUTO-WEB</td>
</tr>
<tr>
<td>50</td>
<td>50 ELECT-MISC COMPN</td>
<td>104 MED PRODUCTS</td>
<td>158 RETAIL-DISCOUNT</td>
<td>200 AUTO-WEB</td>
</tr>
<tr>
<td>51</td>
<td>51 ELECT MSNRS INST</td>
<td>105 MED-BIOMED/GENE</td>
<td>159 RETAIL-DRUG ST</td>
<td>200 AUTO-WEB</td>
</tr>
<tr>
<td>52</td>
<td>52 ELECT PRODS-MISC</td>
<td>106 MED-MEDRC</td>
<td>160 RETAIL-RESTRNTS</td>
<td>200 AUTO-WEB</td>
</tr>
<tr>
<td>53</td>
<td>53 ELECT-CONNECTORS</td>
<td>107 MED-GENERIC DRG</td>
<td>161 RETAIL-HOME FRN</td>
<td>200 AUTO-WEB</td>
</tr>
<tr>
<td>54</td>
<td>54 ELECT PARTS DIST</td>
<td>108 MED-HMO</td>
<td>162 RETAIL-JEWELRY</td>
<td>200 AUTO-WEB</td>
</tr>
</tbody>
</table>

---

106 Appendix Research Wizard 4.0
Glossary of Terms

**Active Ticker List**
A portfolio file being analyzed at the current moment.

**Active Universe**
The group of companies being analyzed at the current moment: either the companies in the current Ticker List, or the companies remaining after a screen has been executed.

**Backtest**
A historical simulation of trading strategy.

**Calculation Expression**
A user-defined screening criteria or report item.

**Consensus Estimate**
An average of analysts' estimates for the particular company.

**Constant e**
e, irrational number occurring widely in mathematics and science, approximately equal to the value 2.71828; it is the base of natural, or Naperian, logarithms. e is transcendental, i.e., not a ROOT of any algebraic equation. It is defined as the limit of the expression \((1 + 1/n)^n\) as n becomes infinitely large.

**Delimited Text File Type**
A text separated by tab characters, commas, or spaces.

**Exponential Function**
Expressions in the form of \(e^{(x)}\).

**Item**
A data element in a Zacks database. An item may contain alphanumeric or numeric data.

**Look Ahead Bias**
The data bias referring to the use of data in a backtest that was not, in reality, available to the analyst at the time the backtest assumes.

**Recent**
Specifies the period with the first non-N/A value of the item.

**Screening**
A process of selecting companies that meet your selected criteria.

**Survivor Bias**
Also, survivorship bias, refers to a database that contains only presently existing companies and no companies that are no longer in business (through the bankruptcy or liquidation).

**Taskbar**
The taskbar is the bar on your desktop that has the Start button on it. Buttons representing programs currently running on your computer appear on this bar.